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AN96841 introduces you to Cypress’s EZ-BLE™ family of Bluetooth Smart modules. EZ-BLE modules are fully qualified
and certified Bluetooth Low Energy (BLE) solutions. EZ-BLE Modules provide a complete BLE solution, integrating a
BLE radio system, two crystals, antenna, and passive components required for BLE operation. This application note
helps you explore the EZ-BLE Module architecture and development tools and shows you how to create your first project
with the EZ-BLE PRoC Module and PSoC Creator ", the development tool used for all EZ-BLE Modules. This application
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1 Introduction

Bluetooth Low Energy (BLE) is an ultra-low-power wireless standard defined by the Bluetooth Special Interest Group
(SIG) for low-power, short-range communication. It features a physical layer, protocol stack, and profile architecture,
all designed and optimized for the lowest power consumption. BLE operates in the 2.4-GHz ISM band, with a data
rate up to 1 Mbps.

BLE is used in a wide range of applications. The use of BLE in these applications also varies widely in production
volume, from very low- to high-volume end products. The use of fully qualified, certified, BLE modules removes time-
consuming RF board design and costly qualification/certification processes. As such, modules have quickly become
the design preference.

The Cypress EZ-BLE Module family provides fully integrated, qualified, and certified programmable systems that
integrate 32-kHz and 24-MHz crystal oscillators, passive components, on-board chip or trace antennas, and a
Cypress BLE chip (PRoC BLE or PSoC 4 BLE), which includes the BLE radio, programmable analog and digital
blocks, memory, and an ARM® Cortex®-MO microcontroller. Cypress EZ-BLE modules are available in footprints as
small as 10 mm x 10 mm x 1.8 mm.

The EZ-BLE PRoC Module enables quick time-to-market and eliminates time-consuming and costly RF hardware
development, certification, and qualification processes, offering an effective alternative to completing a BLE system
design from the ground up. In addition to reducing the cycle time and certification and qualification expenses, the
programmable architecture and GPIOs allow great flexibility by using the PSoC Creator IDE, the schematic-based
design tool for designing applications with EZ-BLE Modules, and a speedy time-to-market.

The BLE stack library is integrated with PSoC Creator and is free-of-cost. It can be easily configured using a simple
graphical user interface allowing you to jumpstart your BLE design in minutes.

EZ-BLE Modules offer a best-in-class current consumption of 150 nA while retaining the SRAM contents and the
ability to wake up from an interrupt. The EZ-BLE Module consumes only 60 nA while maintaining the wakeup
capability |n its nonretention power mode. The capacitive touch-sensing feature in the EZ-BLE Module, known as
CapSense offers an unprecedented signal-to-noise ratio, best-in-class waterproofing, and a wide variety of sensor
types such as buttons, sliders, and proximity sensors. These sensors are gaining increased popularity in wearable
electronic devices such as activity monitors and health and fithess equipment.

The EZ-BLE PSoC Module products provide the most cost-effective solution for sensor-based Internet of Things (10T)
solutions, allowing maximum integration of external ICs used for sensor interface, thereby reducing the overall BOM
cost and size. In addition, programmable analog and digital subsystems allow optimized battery life by offloading
tasks traditionally completed by the main MCU.

2 More Information

Cypress provides a wealth of data at www.cypress.com to help you accelerate the learning on the EZ-BLE Modules,
as well as Cypress’s PSoC and PRoC family of silicon devices. If you are a first-time user of Cypress’s PSoC or
PRoC family of products, it is recommended that you read Appendix A: Cypress Terms of Art for a list of commonly
used terms. If you are seeking an overview of the Bluetooth Low Energy (BLE) standard, read AN91267 - Getting
Started with PSoC® 4 BLE. The following is an abbreviated list of resources for the EZ-BLE Module family:

m  Datasheets describe and provide electrical specifications for each of the EZ-BLE Module.

m  Application Notes and Code Examples cover a broad range of topics. Many application notes include code
examples. PSoC Creator provides additional code examples — see Appendix D: Code Examples.

m  Technical Reference Manuals (TRMs) provide detailed descriptions of the architecture and registers for the
PRoC BLE and PSoC 4 BLE device families.

m  CapSense Design Guide describes how to design capacitive touch-sensing applications with the EZ-BLE
Modules.

m  Development Tools
o PSoC Creator is a state-of-the-art, easy-to-use IDE that offers a unique combination of hardware
configuration and software development based on standard schematic entry.

CySmart BLE Host Emulation Tool for Windows is an easy-to-use GUI that enables you to test and debug
your BLE Peripheral applications. i0S and Android applications are also available.
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m  Development Kits

o CY8CKIT-042-BLE Bluetooth Low Energy (BLE) Pioneer Kit is an easy-to-use and inexpensive development
platform for BLE. This kit includes connectors for Arduino™ compatible shields.

o Each EZ-BLE Module offers a low-cost Evaluation Board to provide an evaluation vehicle for the EZ-BLE
Modules without requiring custom hardware design. These Evaluation Boards are compatible with the
CY8CKIT-042-BLE Bluetooth Low Energy (BLE) Pioneer Kit. See Development Kits and Evaluation Boards
for an overview of kits for the EZ-BLE Modules.

m  Technical Support

o Frequently Asked Questions (FAQs): Learn more about our BLE ecosystem.

o BLE Forum: See if your question is already answered by fellow developers on the PSoC 4 BLE and PRoC
BLE forums.

o Still have questions? Visit our support page and create a technical support case or contact a local sales
representative. If you are in the United States, contact our technical support team by calling our toll-free
number: +1-800-541-4736. Select option 8 at the prompt.

3 EZ-BLE Module Overview
If you are looking for a detailed overview of the Bluetooth Low Energy standard or the Cypress BLE Component, see
AN91267 - Getting Started with PSoC® 4 BLE.

EZ-BLE Modules offer fully integrated and fully certified BLE solutions allowing rapid development and deployment of
your BLE product. This section provides an overview of the EZ-BLE Modules available today. For detailed information
on each module referenced in this section, see Appendix B: EZ-BLE Module Product Details.

All EZ-BLE Modules ship with the components required to achieve full BLE functionality, including:

m  PCB substrate: With footprints as small as 10 mm x 10 mm x 0.5 mm

m  Cypress BLE IC (PRoC BLE or PSoC 4 BLE)

o See the PRoC BLE 128-KB Flash device datasheet for detailed information on the Cypress PRoC BLE IC
with 128-KB Flash

o See the PSoC 4 BLE 128-KB Flash device datasheet for detailed information on the Cypress PSoC 4 BLE
IC with 128-KB Flash

o See the PRoC BLE 256-KB Flash device datasheet for detailed information on the Cypress PRoC BLE IC
with 256-KB Flash

o See the PSoC BLE 256-KB Flash device datasheet for detailed information on the Cypress PSoC BLE IC
with 256-KB Flash

m  Crystal oscillators

o 32.768-kHz watch crystal oscillator (WCO)
o 24.0-MHz external crystal oscillator (ECO)

m  Chip or Trace antenna
m  Passive components (resistor, capacitor, inductor)

m  RF Shield, unless otherwise noted
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EZ-BLE Module Family Features

Table 1 summarizes the features and capabilities of every EZ-BLE Module available from Cypress.

Table 1. EZ-BLE Module Features and Capabilities

Features

Details

BLE Subsystem

BLE radio and link-layer hardware blocks with BLE 4.1- compatible protocol stack

CPU 3-MHz to 48-MHz ARM Cortex-MO CPU with single-cycle multiply
Flash Memory 128-KB or 256-KB

SRAM 16-KB or 32-KB

GPIOs Up to 25 (module-dependent)

CapSense Up to 25 sensors (module-dependent)

CapSense Gestures

Supported

ADC

12-bit, 1-Msps SAR ADC with sequencer

Opamps

Up to four available on EZ-BLE PSoC Modules

Comparators

One available on EZ-BLE PSoC Modules

Current DACs

One 7-bit, and one 8-bit

Power Supply Range

19Vto55V

Low-Power Modes

Deep-Sleep mode at 1.3 pA
Hibernate mode at 150 nA
Stop mode at 60 nA

Serial Communication

Two independent serial communication blocks (SCBs) with programmable 1°C, SPI, or UART

IS Communication Yes
Interface
Timer/Counter/Pulse- 4/4/8

Width Modulator
(TCPWM)

Universal Digital Blocks
(UDBs)

Four available on EZ-BLE PSoC Modules

Clocks

3-MHz to 48-MHz IMO
32-kHz ILO

Power Supply Monitoring

Power-on reset (POR)
Brown-out detection (BOD)
Low-voltage detection (LVD)

Integrated Crystal
Oscillators

24-MHz ECO integrated on module
32-kHz WCO integrated on module

Antenna Type

Trace or Chip Antenna (module dependent)
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EZ-BLE Module Low Power Modes
EZ-BLE Modules support the following five power modes as illustrated in Figure 1:

3.

N

Active mode: This is the primary mode of operation. In this mode, all peripherals are available.

Sleep mode: In this mode, the CPU is in sleep mode, SRAM is in retention, and all the peripherals are available.
Any interrupt wakes up the CPU and returns the system to Active mode.

Deep-Sleep mode: In this mode, the high-frequency clock (IMOl) and all high-speed peripherals are off. The
WDT?, LCD, 12C/SPI, link layer, and low-frequency clock (32-kHz ILOS) are available. Interrupts from GPIO,
WDT, or SCBs* can cause a wakeup. The current consumption in this mode is 1.3 pA for all PRoC BLE devices
in the family.

Hibernate mode: This power mode provides a best-in-class current consumption of 150 nA while retaining
SRAM, programmable logic, and the ability to wake up from an interrupt generated by a GPIO.

Stop mode: This power mode retains the GPIO states. On some modules, wakeup is only possible by using the
external reset (XRES) pin on the module. The current consumption in this mode is only 60 nA.

Notes
! Internal Main Oscillator % Internal Low-Speed Oscillator
2 Watchdog Timer * Serial Communication Blocks can be configured as an 12C, UART, or SPI interface

Figure 1: Power Modes

igi Analo
Current_ Code I?lgltal ' g Clock Wake-Up
Power Mode Consumption Execution Peripherals Peripherals Sources S
(Typical) Available | Available | Available OUIces
Active 2.2mA @ 6 MHz Yes All All All - -
Sleep 1.3 mA No All All All Any interrupt source 0
WDT, LCD, WCO
Deep -Sleep 1.3 UA No I2C/SPI, Link- POR, BOD ' GPIO, WDT, SCB 25 us
32-kHz ILO
Layer
Hibernate 150 nA No No POR, BOD No GPIO 2ms
Stop 60 nA No No No No XRES 2ms

3.3 EZ-BLE Module Device Security

EZ-BLE Modules provide a number of options for the protection of flash memory from unauthorized access or
copying. Each row of flash has a single protection bit; these bits are stored in a supervisory flash row.
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EZ-BLE Marketing Part Number Overview

Cypress offers multiple EZ-BLE Module options to suit each solution’s needs. Each device within the EZ-BLE Module

family has a unique Marketing Part Number (MPN) used for ordering. The MPN format is shown in Figure 2.

f3)
<
o
U

XX

Figure 2: EZ-BLE Module Marketing Part Numbering Format

X XX -X X

Table 2 summarizes the features and capabilities of each specific EZ-BLE Module Marketing Part Number (MPN)
available from Cypress. Click on the specific part number for more detailed information on the device or refer to

Appendix B: EZ-BLE Module Product Details.
Table 2. EZ-BLE Module MPN Features and Capabilities

Shipment Package: 0 = Tape and Reel
Certification Type: 0 = Certified with Shield, 1 = No Certification/No Shield

Device Identification Number: 01 = First product of family

Temperature Range: 0 = Industrial, 1 = Extended Industrial

EZ-BLE Module Type: 0 = Fixed-function bridge, 2 = PRoC Module, 4 = PSoC Module
AntennaType: 0 = No Antenna, 1 = PCB Antenna, 2 = Chip Antenna

Flash Size: 0 = 128KB, 2 = 256KB

Marketing Code: BLE = BLE Product family

Company ID: CY = Cypress

[®)
(] he] —~
> c o — —~ = (a] @ [ =5
SSl A & |gl 2|22 Sl | 23 $5| 8
= © & o) = < c m ; © c 2 m|a =
& & < < = 8 [0 & < 5 ale 8| E
S = c = o < = = e o ) @2 4 o| ©
22| § 8 c| g |g|a? S| = e |ITI2E B
Marketing Part BLE Silicon Module Size x 8 c [T n _ i O 42 S 8
Number Device (mm) < e g =
CYBLE-022001-00 | PRoC BLE 10x10x1.8 Yes | Chip | 21-SMT° | 16 | 128 | 16 | 41 | 2| Yes | 4| Yes | Yes(15) | - -
CYBLE-014008-00 PSoC 4 BLE 11x11x1.8 Yes | Trace | 32-SMT | 25 | 128 | 16 | 41 | 2| Yes | 4| Yes | Yes(25) | 4| 1 4
CYBLE-012011-00 | PRoC BLE 145x19.2x2.0 | Yes | Trace | 31-SMT | 23 | 128 | 16 [ 41 | 2| Yes | 4| Yes | Yes(22) | - -
CYBLE-012012-10 PRoC BLE 145x19.2x1.6 No | Trace | 31-SMT | 23 | 128 | 16 | 41 | 2| Yes | 4| Yes | Yes(22) | - -
CYBLE-222005-00 | PRoC BLE 10x10x 1.8 Yes | Chip | 22-SMT° | 16 | 256 | 32 | 41 | 2| Yes | 4| Yes | Yes(15) | - -
CYBLE-214009-00 PSoC BLE 11x11x1.8 Yes | Trace | 32-SMT | 25 | 256 | 32 | 41 | 2| Yes | 4| Yes | Yes(25) | 4| 1 4
CYBLE-212019-00 | PRoC BLE 145x19.2x2.0 | Yes | Trace | 31-SMT | 23 | 256 | 32 [ 41| 2| Yes | 4| Yes | Yes(22) | - -

Note

® CYBLE-222005-00 is drop-in compatible with the CYBLE-022001-00. The additional pin included on the CYBLE-222005-00 is the Vrer input

pad (pad 6), which is a new pad location not present on the CYBLE-022001-00. The Vger connection is optional on the CYBLE-222005-00.
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4 Development Tools

Cypress supports the EZ-BLE Modules with high-quality software tools, with access to a suite of world-class
Integrated Design Environments (IDEs).

Cypress provides the following software to get started with a EZ-BLE Module design:

1. PSoC Creator
2. Bluetooth Low Energy Component (part of PSoC Creator)
3. CySmart PC application
4. CySmart Android app
5. CySmartiOS app
4.1 PSoC Creator
PSoC Creator is a free Windows-based Integrated Design Environment (IDE). It enables you to design hardware and
firmware systems concurrently. As Figure 3 shows, with PSoC Creator, you can:
1. Drag and drop Components to build your 3. Configure the Components using
hardware system design in the main design configuration tools.
workspace. 4. Explore the library of more than 100
2. Co-design your application firmware with the Components.
PSoC hardware. 5. Review the Component datasheets.
Flgure 3. PSoC Creator Schematic Entry and Components
19
: d Drag and Drop
Configure BLE § y Components
A —— P
: :»::l:::‘l:j::;ewhmmﬁmaaniwwm :g

Broadcaster/Observer
“Thia mode doss net suppar connestons
HestConbroller Mode

e Components

Configur

wah a ot stack 1ang 8

Prfle corfigusion

e —
ol ——— @

GAPre:  [Pephesd =

28 Thems Mansgenent

] Use BLE low power mods

Ooen dataest
Bletooth Low Ensegy (BLE)

Dt oK ool Cance.
! Inst_N
ct ; f 9 Bluetooth’
) < CYPRESS SART
A B I b
e — Bluetooth Low Energy (BLE)
. ——— Ty 20
/|| R BLE_1
Features BLE
® Bluetooth v4.1 compliant protocol stack .
® Generic Access Profile (GAP) Features 9 Bluetnsq},!!

o Broadcaster, Observer, Peripheral and Central roles.
o Supports role reversal between Peripheral and Central
o Userdefined advertising data

© Bonding support for up to four devices
© Security modes 1.and 2
Generic Attribute Profile (GATT) Features

o GATT Client and Server
o 32-bit UUIDs

Special Interest Group (SIG) adopted GATT-based Profiles (19) and Services (24), and
quick prototype of new profile design through intuitive GUI Custom Profile development

Security Manager features
o Pairing methods: Just works, Passkey Entry, Out of Band
o Authenticated man-in-the-middle (MITM) protection and data signing
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PSoC Creator Help

Visit the PSoC Creator home page to download and install the latest version of PSoC Creator. Then launch PSoC
Creator and navigate to the following items:

®  Quick Start Guide: Choose Help > Documentation > Quick Start Guide. This guide gives you the basics for
developing PSoC Creator projects.

m  Simple Component example projects: Choose File > Open > Example projects. These example projects
demonstrate how to configure and use PSoC Creator Components.

m  Starter designs: Choose File > New > Project > PSoC 4 Starter Designs. These starter designs demonstrate
the unique features of PSoC 4 BLE.

m  System Reference Guide: Choose Help > System Reference > System Reference Guide. This guide lists
and describes the system functions provided by PSoC Creator.

m  Component datasheets: Right-click a Component and select “Open Datasheet.” Visit the PRoC BLE
Component Datasheets page for a list of all PSoC 4 BLE Component datasheets.

®  Document Manager: PSoC Creator provides a document manager to help you to easily find and review

document resources. To open the document manager, choose the menu item Help > Document Manager.

4.3 Bluetooth Low Energy Component

The Bluetooth Low Energy Component inside PSoC Creator provides a comprehensive GUI-based configuration
window that lets you quickly design BLE applications. The Component incorporates a Bluetooth Core Specification
v4.1-compliant BLE protocol stack and provides API functions to enable user applications to interface with the
underlying Bluetooth Low Energy Sub-System (BLESS) hardware via the stack.

The Component supports the SIG-adopted GATT-based profiles and services as well as custom BLE profiles and
services, and it allows various GAP and GATT roles to be configured. The Component generates the necessary code
for a particular profile and service operation, as configured in the GUI, abstracting the underlying BLE stack and
hardware configuration so that you can concentrate on the system design.

The BLE Component also provides profile Application Programming Interfaces (APIs) to design BLE solutions without
requiring manual stack-level manipulation. The exception to this is the L2CAP configuration specified in Bluetooth
v4.1, which allows advanced users to configure the L2CAP layer of the stack if desired.

See AN91267 - Getting Started with PSoC® 4 BLE for a detailed overview of Bluetooth Low Energy (BLE) and the
BLE Component.

4.4 CySmart PC Application

The CySmart Host Emulation Tool is a Windows application that emulates a BLE Central device using the BLE
Pioneer Kit's BLE Dongle; see Figure 12. It is installed as a part of the BLE Pioneer Kit installation and can be
launched from right-click options in the BLE Component. It provides a platform for you to test your EZ-BLE Module
Peripheral implementation over GATT or L2CAP connection-oriented channels by allowing you to discover and
configure the BLE Services, Characteristics, and Attributes on your Peripheral.

Operations that you can perform with CySmart Host Emulation Tool include, but are not limited to:

m  Scan BLE Peripherals to discover available devices to which you can connect.

m  Discover available BLE Attributes including Services and Characteristics on the connected Peripheral device.
m  Perform read and write operations on Characteristic values and descriptors.

®  Receive Characteristic notifications and indications from the connected Peripheral device.

m  Establish a bond with the connected Peripheral device using BLE Security Manager procedures.

m  Establish a BLE L2CAP connection-oriented session with the Peripheral device and exchange data per the
Bluetooth 4.1 specification.

Figure 4 and Figure 5 show the user interface of CySmart Host Emulation Tool. For more information on how to set
up and use this tool, see the CySmart user guide from the Help menu.
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Figure 4. CySmart Host Emulation Tool Master Device Tab
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Figure 5. CySmart Host Emulation Tool Peripheral Device Attributes Tab
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4.

ol

CySmart Mobile App

In addition to the PC tool, you can download the CySmart mobile app for iOS or Android from the respective app

stores. This app uses the iOS Core Bluetooth framework and the Android built-in platform framework for BLE
respectively to configure your BLE-enabled smartphone as a Central device that can scan and connect to Peripheral

devices.

The mobile app supports SIG-adopted BLE standard Profiles through an intuitive GUI and abstracts the underlying
BLE Service and Characteristic details. In addition to the BLE standard Profiles, the app demonstrates a custom
Profile implementation using Cypress’s LED and CapSense demo examples. Figure 6 and Figure 7 show a set of
CySmart app screenshots for the Heart Rate Profile user interface. For a description of how to use the app with BLE

Pioneer Kit example projects, see the BLE Pioneer Kit Guide.
Figure 6. CySmart iOS App Heart Rate Profile Example
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Figure 7. CySmart Android App Heart Rate Profile Example
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5 Development Kits and Evaluation Boards

Cypress provides an easy-to-use development kit to help you prototype your EZ-BLE Module design.

CY8CKIT-042 BLE Pioneer Kit

The CY8CKIT-042 BLE Pioneer Kit, as shown in Figure 8, is an Arduino Uno-compliant BLE development kit for the
PRoC BLE and PSoC 4 BLE family of devices, including the EZ-BLE Modules. The CY8CKIT-042 BLE kit consists of
pluggable BLE modules that connect to a baseboard. The Pioneer Kit can be powered through the USB interface or

with a coin cell battery.

The Pioneer baseboard and RF module combination enables you to develop battery-operated low-power BLE
designs that work in conjunction with standard Arduino shields and additional PSoC 4 and PRoC BLE device
capabilities such as the CapSense user interface on the Pioneer baseboard.

5.

=

The kit contains a BLE USB dongle that acts as a BLE master and works with the CySmart application to provide a
BLE master emulation platform on non-BLE Windows systems.

Cypress offers evaluation boards for each of the EZ-BLE Modules to evaluate and develop with the Cypress module
without the need to design custom hardware.

Figure 8. BLE Pioneer Kit

om0 AE QUICK START GUDE

PSOC* 4/PROC™ BLUETOOTH® LOW ENERGY
T-042-0E QuICK START GuiDE

CY8CKIT-042-BLE BLUETOOTH"
LOW ENERGY PIONEER KIT

The kit includes of a set of BLE example projects and documentation that should help you get started with developing
your own BLE applications. Visit www.cypress.com/go/CY8CKIT-042-BLE to get latest updates on the kit and to
download kit design, example projects, and documentation files.
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EZ-BLE Evaluation Boards
For details and images of each EZ-BLE Evaluation Board, see Appendix C: EZ-BLE Evaluation Board Details.

5.

N

The EZ-BLE Evaluation Boards are designed to fan out the connections of each respective EZ-BLE Module to
headers compatible with the CY8CKIT-042-BLE Pioneer Kit. The EZ-BLE Evaluation boards allow you to evaluate the
Cypress EZ-BLE Modules without having to design custom hardware to mount the Cypress EZ-BLE Module.

Table 3 lists each of the available EZ-BLE Modules and their corresponding evaluation board part numbers. Click on
your evaluation board for additional information.

Table 3. EZ-BLE Modules and Corresponding Evaluation Board Part Numbers

EZ-BLE Module Part Number EZ-BLE Evaluation Board Part Number
CYBLE-022001-00 CYBLE-022001-EVAL
CYBLE-014008-00 CYBLE-014008-EVAL
CYBLE-012011-00 CYBLE-012011-EVAL
CYBLE-012012-10 CYBLE-012011-EVAL
CYBLE-222005-00 CYBLE-222005-EVAL
CYBLE-214009-00 CYBLE-214009-EVAL
CYBLE-212019-00 CYBLE-212019-EVAL

Each EZ-BLE Evaluation Board contains the following components:

m  Cypress EZ-BLE Module — soldered directly to the Evaluation Board
m  PCB substrate used for I/O fan out
m  Connection headers

m  Cmnog capacitor (for use with Capacitive Sensing elements on the CY8CKIT-042-BLE Kkit).
Note: Certain EZ-BLE Modules integrate the Cmoq Capacitor on the module (for example, CYBLE-014008-00). In
these cases, the associated EZ-BLE evaluation board will not include an addition Cmoq Capacitor.

®  Inductors (for power supply noise reduction) — refer to your EZ-BLE Module datasheet for recommended external
components)

EZ-BLE Evaluation Boards are designed to simulate the placement and connection of the EZ-BLE Modules in a final
application. All host-side layout pattern recommendations (as shown in each specific module’s datasheet) are
followed for each evaluation board.

Note that not all connections available on the CY8CKIT-042-BLE are populated on the EZ-BLE Evaluation Boards.
This is due to the number of I/Os supported on the EZ-BLE Modules. When designing applications, PSoC Creator will
only display connections that are available on the specific EZ-BLE Module that you are designing with. See Appendix
C: EZ-BLE Evaluation Board Details for details on the connections available for each of the EZ-BLE Evaluation
Boards and the corresponding connections on the CY8CKIT-042-BLE development kit.

To place any of the EZ-BLE Module Evaluation Boards on the CY8CKIT-042-BLE baseboard, locate the 20-pin (J11)
and 24-pin (J10) connection headers, as shown in Figure 9.
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Figure 9. CY8CKIT-042-BLE Baseboard with J10 and J11 Headers to Connect the EZ-BLE EVAL Board

Plug the EZ-BLE Evaluation Board into the CY8CKIT-042-BLE baseboard on headers J10 and J11, while keeping the
antenna directed outside. See Appendix C: EZ-BLE Evaluation Board Details for images showing proper connection
to the CYBCKIT-042-BLE baseboard for each module. Note that there are notches on both the J10 and J11 headers

that will ensure proper insertion orientation.
To remove the EZ-BLE Evaluation Board from the CYS8CKIT-042-BLE baseboard, hold the CY8CKIT-042-BLE

baseboard in one hand and the EZ-BLE Evaluation Board in the other, as shown in Figure 10, and pull it out using a

rocking motion.
Figure 10. Removing the EZ-BLE Evaluation Board from the CY8CKIT-042-BLE Baseboard

Each of the connections made from the EZ-BLE Evaluation Board to the CY8CKIT-042-BLE baseboard are

accessible on the Arduino-compatible headers located on the CY8CKIT-042-BLE baseboard. Figure 11 shows the

Arduino-compatible headers and port-pin identifiers located on the CY8CKIT-042-BLE baseboard.

Need support? Click here.
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Figure 11. Arduino Compatible Headers on CY8CKIT-042-BLE Baseboard
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The connections above are labeled according to the CY8CKIT-042-BLE baseboard pinout. For the equivalent and
available connections used with your EZ-BLE Evaluation Board, see Appendix C: EZ-BLE Evaluation Board Details.
For additional information on the CY8CKIT-042-BLE, see the CY8CKIT-042-BLE product web page.
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6 EZ-BLE Module Development Setup

Figure 12 shows the hardware and software tools required for evaluating BLE Peripheral designs using the EZ-BLE
Module Evaluation Boards (for example, CYBLE-022001-EVAL — green board in Figure 12). The BLE Pioneer Kit (red
board in Figure 12) acts as a Peripheral that can communicate with either a CySmart iOS/Android app or the
CySmart Host Emulation Tool that acts as a Central device. The CySmart Host Emulation Tool also requires a BLE
Dongle (black board in Figure 12) for its operation. The dongle is included in the CY8CKIT-042-BLE kit. The
development system setup required for programming and debugging a BLE design is shown in Figure 13.

Figure 12. BLE Functional Setup
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Figure 13. BLE Development Setup
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My First EZ-BLE Module Design section will walk you through a step-by-step configuration of the BLE Component for
creating a simple Peripheral application. You may refer to application notes AN91184 and AN91162 for a step-by-
step description of how to use the BLE Component to develop applications using BLE standard and custom Profiles.
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7 Module Placement and Enclosure Considerations

EZ-BLE Modules are designed to be soldered to a host PCB to provide seamless BLE connectivity. To maximize RF
performance of the final product, care needs to be taken on the placement of the module and antenna. This section
describes in detail the recommended placement of the module on a host board to ensure optimal RF performance.
This section also details the effect of metallic or nonmetallic enclosure and metal obstructions near the EZ-BLE
Module.

7.

=

Antenna Ground Clearance

A monopole antenna requires that no ground plane is below the antenna. The ground plane below it will not allow the
field to propagate. This is defined as the Ground Clearance requirement. However, after some distance, a ground
must be present for a monopole antenna. Defining this region is a very significant step for any antenna design. The
Ground Clearance region defines the bandwidth and the efficiency of the antenna.

Each specific EZ-BLE Module Marketing Part Number specifies the Ground Clearance used for the design of the
module, and offers recommended additional ground keep-out area to maximize the RF performance. The examples
below reference the CYBLE-022001-00 module specifically. For details on other modules, see the specific module
datasheet.

The CYBLE-022001-00 uses the Johansson 2450AT18B100 chip antenna. The datasheet of the antenna requires a
Ground Clearance of 6.5 mm x 6.5 mm when placed as shown in Figure 14.

Figure 14. Antenna Clearance

Mo Ground

4mm Antenna

o
6.5mm

In Figure 14, the chip antenna is placed at the edge of the module. The yellow area in Figure 14 does not have any
ground on any layer. The module placement in a host board needs to ensure that no traces or ground layers of the
host board comes within this region. Any ground plane below a monopole antenna degrades the radiation and
adversely affects the RF efficiency.

WWW.Cypress.com Document No.: 001-96841 Rev. *E Need support? Click here. 17


http://www.cypress.com/

PERFORM
Getting Started With EZ-BLE™ Module

7.2 Module Placement in a Host System
The EZ-BLE Module is soldered to a host board and a clearance must be provided for the antenna where no routing
or ground is allowed on any layer. Placing the module at the edge of the host board is recommended as it provides
the best RF performance and simplifies the requirement of not routing signal or ground traces under the antenna
Ground Clearance region. Figure 15 shows four placement options on a host board, with option 1 being the most
efficient.
Figure 15. Module Placement in a Host Board

./.

. /
Antenna Tip e
NZ
Ground Clearance \
Region Shield Clearance Region

outside of module

Figure 15 shows an example of four positions of the module in a host board, “1”, “2”, “3”, and “4”. The white area
shown around the module is the clearance area. For the antenna in question, it is recommended to provide a
clearance area of 4 mm in each direction. For details on the recommended clearance area for your EZ-BLE Module,

see the specific module datasheet.

As can be seen in Figure 15, when placing the module at the edge of the host board, the additional clearance area is
not required as the antenna is facing outwards (with no possibility of signal or ground traces to be beneath the
antenna Ground Clearance region). Conversely, if the module is placed in the middle (placement option “2”) of the
host board, the clearance area must be provided in order to achieve an optimal RF performance.

Placement option “1” is the best option shown in Figure 15, because it removes the need to reroute signal or ground
traces away from the Ground Clearance region of the module (because no GPIO are located at the top left corner of
the module). Furthermore, it does not require any additional clearance area, because the antenna faces outward, with

the antenna tip exposed to open space.
In placement options “3” and “4”, although the module is placed at the edge of the host board, the antenna tip is not
exposed to free space.

Placement option “2” not only wastes PCB real estate, but also provides diminished RF performance compared to
position “1”, as we can have traces facing the antenna tip.
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7.3 Enclosure Effects on Antenna Performance
Antennas used in consumer products are sensitive to the PCB RF ground size, the product’s plastic casing, and
metallic enclosures. This section describes the effect of each of these environmental factors on RF performance.
7.3.1 Antenna Near Field and Far Field

Every antenna contains two regions surrounding it: 1) the near field and 2) the far field.

The near field is the region where the radiated field has not yet formed. In this region, the electric and magnetic fields
are not orthogonal to each other. This region is very close to the antenna in distance. The near-field region has two
regions: the reactive near-field region and the radiating near-field region. The transition to a far-field region happens
in the radiating near-field region.

The radiation field is formed after the transition to the far field region. In this region, the relative angular variation of
the field does not depend on the distance. This means that if we plot the angular radiation field at a distance from the
antenna in the far-field region, their shapes remain the same. Only with distance, the field strength decreases.
However, the shape of the radiation pattern remains the same with respect to the angular variation. This region is
called the far-field region. An object in the far field does not affect the radiation pattern much. However, any
obstruction in the near field can completely change the radiation pattern. If the obstruction is metal, the effect on the
radiation pattern is much more pronounced. Figure 16 shows the regions for a dipole antenna.

Figure 16. Near and Far Field
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For a module based on a 2.4-GHz chip antenna, the near field extends up to 4 mm.

7.3.2 Effect of Nonmetallic Enclosure
Any plastic enclosure changes the resonating frequency of the antenna. The antenna can be modeled as an LC
resonator whose resonant frequency decreases when either L (inductance) or C (capacitance) increases. A larger RF
ground plane and plastic casing increase the effective capacitance and thus reduce the resonant frequency. See the
application note AN91445 for more details on the effect of an enclosure.

Figure 17 details a module antenna in a plastic enclosure. The clearance from the antenna to the plastic enclosure
can be as little as 2 mm. However, clearance of this amount can affect the tuning of the antenna. This can be
resolved by retuning the antenna; however for a module solution, it is not recommended to attempt retuning of the
antenna. To minimize effects on the module antenna, it is recommended to have a minimum clearance of 5 mm.
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Figure 17. Cypress EZ-BLE Module Inside of a Plastic Mouse Enclosure
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7.3.3 Effect of Metallic Objects
An antenna is sensitive to the presence of metallic objects in its vicinity. A metallic object shorts the electric field and
thus changes the radiation field. Depending on the size of the obstruction, electromagnetic waves go through different
diffraction patterns or may be completely shielded by the metallic object.

Metallic objects in the near field can have a drastic impact on the radiation pattern. The thickness of the
CYBLE-022001-00 module is 1.8 mm (including the antenna) and the near field of this module extends up to 4 mm
from the antenna. Therefore, it is recommended that any metallic obstruction be at least 6.2 mm away from the PCB
plane to avoid negative effects to the RF performance. Cypress recommends an 8-mm gap from the module PCB
plane to any metallic enclosure. Figure 18 details the required clearance from the EZ-BLE Module to small metal
obstructions.

Figure 18. Clearance from Small Metal Obstructions

ﬁ

7.3.4 Recommendations for Placement over a Large Metal Plane
The other effect of metal is the formation of an image antenna. The best practice in this case is to orient the metal
orthogonal to the antenna to ensure minimum effects. If the length or width of the plane approaches the size of the
module, it is considered a large metal objects near the antenna. Figure 19 details two placement options for this
scenario. Of these two placement options, option “1” should be avoided.

|
|
|
!
Module :
i
|
|

8 mm

It is recommended to not have any large metallic objects parallel to the antenna. This has a drastic effect because the
image antenna is of opposite polarity. The interference caused by such an antenna is destructive to the RF radiation.

If it is not possible to avoid a large metallic object running parallel to the module plane, then it is recommended to
maintain a distance (h) of at least 30 mm. This will ensure that the interference caused by the image antenna will not
be completely destructive. The radiation will be strongly directional below the 30-mm distance and the efficiency will
dramatically drop at a distance (h) below 8 mm. At a distance (h) of around 2 mm, the radiation efficiency can go
below 20%.
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Figure 19. Clearance from a Large Metal Plane
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7.4 Guidelines for Enclosures and Ground Plane
The best practices with respect to enclosure design and ground planes are summarized:

= Ensure that there is no component, mounting screw, or ground plane near the tip or the length of the antenna
located on the EZ-BLE Module.

= Ensure that no battery cable, microphone cable, or trace crosses the antenna trace on the PCB.

= Ensure that the antenna is not completely covered by a metallic enclosure. If the product has a metallic casing or
shield, the casing should not cover the antenna. No metal is allowed in the antenna near the field.

= Ensure that paint on plastic enclosures is nonmetallic near the antenna.

= The orientation of the antenna should be in-line with the final product orientation (if possible) so that radiation is
maximized in the desired direction. The polarization of the receive antenna and the position of the receive antenna
should be taken into account so that the module can be oriented to maximize radiation.

= There should not be any ground directly below the antenna Ground Clearance region of the module.
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8 Manufacturing with EZ-BLE Modules

EZ-BLE Modules are intended to be used with traditional Surface Mount Technology (SMT) manufacturing lines and
are compatible with industry-standard reflow profiles for Pb-free solders.

8.

=

SMT Manufacturing Pick-and-Place

The EZ-BLE Modules should be picked up from the topside of the module using industry-standard pick-and-place
machinery and nozzles. The ideal location for picking up the module is on the shield area of the module. For the
optimal location for your EZ-BLE Module, see the module’s datasheet.

Each EZ-BLE Module marketing part number has a unique center-of-mass detailed in each product’s datasheet. This
center-of-mass is the area that represents the optimal location to pick up the unit with the nozzle. Using the center-of-
mass guidelines for pick-and-place location will minimize SMT line disturbances caused by units releasing
prematurely from the nozzle.

Figure 20 shows an image of a nozzle used by Cypress manufacturing the CYBLE-022001-EVAL Evaluation Board
product. See the center-of-mass dimensions in each module’s datasheet to select an appropriate nozzle for your
manufacturing line equipment.

Figure 20. Nozzle Used by Cypress for Evaluation Board Production

Figure 21 shows an image of the CYBLE-022001-00 picked up at the center-of-mass by the nozzle referenced above.

Figure 21. Image of Nozzle Used by Cypress for Evaluation Board Production

8.2 Manufacturing Solder Reflow

EZ-BLE Modules are compatible with industry-standard reflow profiles for Pb-free solder. Table 4 details the solder
reflow specifications for all EZ-BLE Modules.

Table 4. EZ-BLE Module Solder Reflow Specification

Module Package Maximum Peak Temperature Time at Maximum Temperature

All Packages 260 °C 30 seconds
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9 My First EZ-BLE Module Design

This section gives you a step-by-step process for building a simple BLE Pioneer Kit-based design with the EZ-BLE
Module Evaluation Board using PSoC Creator. This example project is specific to the CYBLE-022001-EVAL
Evaluation Board (using the CYBLE-022001-00 EZ-BLE PRoC Module).

9.

=

About the Design

This design implements a BLE Find Me Profile in the Target role that consists of an Immediate Alert Service (IAS).
Alert levels triggered by the Find Me Locator are indicated by varying the state of a LED on the BLE Pioneer Kit, as
Figure 22 shows. Two status LEDs indicate the state of the BLE interface.

Figure 22. My First EZ-BLE Module Design

Find Me Collector Find Me Target
(CySmart PC/Mobile App) (BLE Pioneer Kit)

IAS GATT Server

IAS GATT Client

Service

Write Alert Level

Immediate Alert Service e e
Alert Level

9.2 Prerequisites
Before you get started with the implementation, make sure that you have a BLE Pioneer Kit, the CYBLE-022001-
EVAL board, and have installed the following software:

m  PSoC Creator 3.3 SP1 or later with PSoC Programmer 3.23.1 or later
m  CySmart Host Emulation Tool or CySmart iOS/Android app

You can create your first EZ-BLE PRoC Module design in four steps:

Configure the design in the PSoC Creator schematic page.

2. Write the firmware to initialize and handle BLE events.
3. Program the EZ-BLE PRoC Module on the BLE Pioneer Kit.
4. Test your design using the CySmart Host Emulation Tool or mobile application.

9.3 Part 1: Configure the Design

This section takes you on a step-by-step guided tour of the design process. It starts with creating an empty project
and guides you through schematic design entry. You can skip this section if you simply wish to try the example
project provided with this application note without going through the build process.

1. Install PSoC Creator 3.3 SP1 or newer on your PC. After installation, a registration page for Keil license will be
shown. This can be ignored for the EZ-BLE PRoC Module.

2. Start PSoC Creator, and from the File menu, choose New > Project, as Figure 23 shows.
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Figure 23. Creating a New Project

4 PSoC Creator3.2

File | Edit View Project Build Debug Tools Window Help
| New }”EE Project... | b 23 3 X -
Open * | Ty Eile.. [ﬂ, _
Exarnple Project... - 31X _/m]—
Close Ctrl+F4 PSOC® CreatOFm
g
£
8

Note: If you choose to open the completed example project directly instead of creating the project from
scratch, you may be informed that your version of PSoC Creator has newer components available than were
used in the creation of the example project associated with this application note. The information screen will
appear as shown in Figure 24. The details contained in this screen will differ based on the version of PSoC
Creator being used.

Figure 24. Component Update Information

PSoC Creator Info pftMO114 n

The following new system-level components have been found: cy_Ifclk,
LIN_Dynamic. The Design-Wide Resources file, My_First_EZ-
BLE_Design.cydwr, stores the selected version ofthese components. The
newly found component versions need to be saved so they don't auto-
update to the latest version in the future iffwhen newer versions ofthe
components become available.

Show Details == oK

Select OK and your workspace opens. To build and program an application to your EZ-BLE Module, you
must first update the components used in the example project using the Component Update Tool. To access
the Component Update Tool, left-click the warning icon that is present in the lower right corner of PSoC
Creator, as shown in Figure 25.

Figure 25. Component Update Tool Warning Icon Location

@ |1 Errors 0Warnings 0 Motes

Before the Component Update Tool opens, you will be prompted if you wish to save your any unsaved
documents before proceeding, as shown in Figure 26. Select Yes to proceed with the component update or
No to exit the update, or click Show Details for more information. The Component Update Tool will not

perform updates on unsaved documents.
Figure 26. Prompt for Saving Documents Prior to Component Update

PSoC Creator Info sdb.M0037 “

There are unsaved documents in the project Would you like to save these

D
v documents to continue with the update process?

Show Details >> Yes No
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After selecting Yes in Figure 26, the Component Update Tool will prompt you to update any Components
that are out of date. Figure 27 shows the Component Update Tool. Select Next to proceed to the next page
of the component update.

NOTE: For users of PSoC Creator 3.3 SP1 Early Access, the BLE component should be updated to
V2.30, not V3.0. V3.0 is not required for any of the EZ-BLE Modules described in this Application

Note.
Figure 27. Component Update Tool
Component Update Tool ? “
Select components to update
(Out-of -date components found which may contain defectsincompatibilities that could affect your design. We strongly
recommend updating all components.
Mame Available Versions |
=2 My._First_EZ-BLE_Design
E}@ TepDesign.cysch
M ADC SAR SEQ P4 v
- cy pins v
£+ BLE v
kd B 0 3.0 W
-y Battery 3.0
H )
L[] Battery [v1.0]
=M SCB P4 ;-;0
~[#] SCB_2 [va.0] 120
1.10
~[#] 5CB_1 [v2.0
ol 5C8.1 (20) 1.0 (Obsolete)
=9 TCPWM P4 [
Net> || Cancel
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After clicking Next, the Component Update Tool will preview the components that will be updated and
provide the option to “Create workspace archive before updating.” Select the desired option and then click
Finish. Figure 28 shows the Component Update Tool with the option to create a workspace archive before
updating. After clicking Finish, you may proceed after the status window shown in Figure 29 is no longer

present.
Figure 28. Review, Archive and Update Components
Component Update Tool ? “
Review pending updates
Click "Finish’to complete the updates, "Back’to alter them, or 'Cancel’to exit without any changes.
Mame Mew Version ™
My_First_EZ-BLE_Design
ToepDesign.cysch
ADC_SAR_Seq_1 [v2.0] 2.30
SDI [w2.10] 2.20
ADC_In [v2.10] 2.20
Alert_LED [v2.10] 2.20
Advertising_LED [v2.10] 2.20
WS [w2.10] 2.20
SCK [w2.10] 2.20
SwW4a [v2.10] 2.20
CIAMY [..7 101 e e 1 ] "
I [] Create workspace archive before updating I
MNote: This update includes at least one major version change. We recommend using the checkbox to create a workspace anchive.
< Back Finish Cancel
Figure 29. Component Update in Progress
Updating Components...
|
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Select the target hardware from the drop-down menu as "Module: CYBLE-022001-00" as shown in Figure 30 and
click Next. All EZ-BLE Modules are located under the “Target Hardware” drop-down list. If you are using a
custom EZ-BLE Module hardware or a different EZ-BLE part number, choose the "Launch Device Selector”
option in Target device and select the appropriate part number.

Figure 30. Selecting the Target Hardware

w

? IEl

Create Project - Module: CYBLE-022001-00

Select project type
Choose the type of project —design, library, or workspace.

Design project:

(®) Target hardware: | Module: CYBLE-022001-00

() Target device:
(") Library project

() Workspace

4. Select the “Pre-populated schematic” project template as shown in Figure 31 and click Next. In addition to the
Pre-populated schematic project template, you can alternatively begin from a Code example project.

Note: EZ-BLE PSoC Modules provide the additional option to start with an Empty Schematic project template.
Figure 31. Selecting the Project Template
x|

Create Project - Module: CYBLE-022001-00

Select project template
Choose a schematic template or start your design with a kit or example project.

1101] | Code example
10| | Choose from our library of code examples.

= | Pre-populated schematic
=] Start with typical MCU functions (ikke UART, ADC, etc.).

et > Cancel

Document No.: 001-96841 Rev. *E Need support? Click here.

Www.cypress.com


http://www.cypress.com/

===¢ CYPRESS

PERFORM
Getting Started With EZ-BLE™ Module

6. Give the workspace and the project a hame such as “My_First EZ-BLE_Design,” as Figure 32 shows. Choose
an appropriate location for your new project, and then click Finish.

Figure 32. Naming the New Project

Create Project - Module: CYBLE-022001-00 ? “

Create Project

Choose a name and location for your design.

Workspace: Create new workspace
Workspace name: |My_First_EZ-BLE_Design

Location: C\Projects

Project name: | My_First_EZ-BLE_Design|

5. Creating a new project generates a project folder with a baseline set of files. You can view these files in the
Workspace Explorer window, as Figure 33 shows. Open the project schematic file TopDesign.cysch by double-

clicking it.
Figure 33. Opening TopDesign Schematic
Workspace Explorer (1 project) >0 X
g

3 Workspace 'My_First_EZ-BLE_Design' (1 Projects)

EE‘ *Project 'My_First_EZ-BLE_Design’ [CYBLE-022001-00] w
]ﬂ’ TopDesign.cysch :E'

_*P My_First_ EZ-BLE_Design.cydwr e
~I) Header Files F
M) Source Files &
Q main.c Eﬁ_

el

m

c

"
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6. You can see pre-populated Components in the schematic as Figure 34 shows.
Figure 34. Pre-populated Components
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5CB 1 SCB 2 125 Master
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[CapSenseCSD| | sokl—— {7 SCK
............ D > >l 128 Clock[ T }—relock wsf— ws
B Shave | rcinterrupt
Aulo (SmarSens | |
| rx_dmadl
GPIO LEDs ADDITIONAL COMPONENTS
LCD Seg
R ved Sagmant1rh) TCPWM 4 TCPWM_2 TCPWM 3
T TCPWM TCPWM TCPWM
.{* K Clock ,D hs_clk ovle po avle
¥ un un un
o pkEO R g kED A cc ce cc
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fine_n = line_n |= line_n =
BWM 1 Prelock clock clock
GPIO BUTTONS PV interrupt interrupt interrupt
tc
P W pwmi |- iy s iy
i pwm2 i - TS
e SW2 i Glock 5[} |
1 ! SWA s L
! T R e Ntemrupt|
ol W i UDE)
é LA e SWE Notes
Vss ; 1. Disable/Enable the components as per your design
2. Drag Pins from the Component Catalog and connect to the components

=
P
&

3. Open cydwr file from the workspace and connect Pins to the GPIOs.

7. Disable/enable the Components per your design. For this design, right-click on each of the Components as follows
and enable/disable Components/features as Figure 35 shows:

u In the BATTERY MONITOR section, disable the ADC_SAR_Seq_1 and pin ADC_In

= In the GPIO BUTTONS section, disable all switches (SW1 through SW5)

] In the TIMER section, disable TCPWM_1, Clock_1, and ISR_1

= In the SERIAL INTERFACES section disable SCB_1 and SCB_2 (12S_1 should already be disabled)
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Figure 35. Enable/Disable Components
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TIMER
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1. Disable/Enable the components as per your design

2. Drag Pins from the Component Catalog and connect to the components
3. Open cydwr file from the workspace and connect Pins to the GPIOs
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An alternative to disabling the Components is to delete the unused Components. Deleted Components can be
replaced from the Component Catalog if required.

8.

36. The new LED is automatically named “LED_3” in the schematic view. You will need to move the existing
Components first in order to have enough space in the schematic. You can move selected Components by
holding the left mouse button and dragging or by using the arrow keys.

Figure 36 Adding One More LED

GPIO LEDs

Add one more LED by selecting the following schematic and right-clicking Copy and Paste as shown in Figure

Www.cypress.com
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9. Double-click the BLE Component on the schematic to configure it as a “BLE Find Me Target” with the following
properties:

m  GAP Peripheral role with Find Me Target (GATT server) configuration

m  GAP Device Name set to “Find Me Target” and Appearance set to “Generic Keyring.” This configures the
device name and type that appears when another device attempts to discover your device.

m  General mode with an advertising timeout of 30 seconds and a fast advertisement interval of 20 to 30 ms.
Fast advertising allows quick discovery and connection but consumes more power due to increased RF
advertisement packets.

m  Advertisement Packet with Immediate Alert Service enabled and Scan Response Packet with Local Name,
Tx Power Level, and Appearance fields enabled.

m  GAP security set to the lowest possible configuration that does not require authentication, encryption, or

authorization for data exchange (Mode 1, No Security)

Figure 37 to Figure 43 show the BLE Component screenshots for this configuration.

Note You do not need to change the default configuration of the BLE Component in the Profiles tab for this design.

Figure 37. BLE Component General Configuration
Configure 'BLE’ lilﬁ

Mame: BLE

- General | Profles " GAP Settings |~ L2CAP Settings -~ Advanced | Builtin | 4 #

[ Load configuration [ Save configuration

@ Profile
Profile: [Find Me ~|
Profile role: [ Find Me Target (GATT Server) -
GAProle: [ Periphersl -

Ower-The-Air bootloading with code sharing
@ Disabled

() Stack only

() Profile onby

' Broadcaster/Observer

) Host Controller Interface (HCI)
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Figure 38. BLE Component GAP General Settings

' h
Configure 'BLE" m

Mame: BLE

GAP Settings | L2CAP Settings | Advanced | Builtn | 4k

Uevice address
(=) Peripheral role _ Public address (Company ID - Company assigned):  00AD50-00000
Advertisement settings
Advertisement packet
ice.lnhrespic::{e pa;kei ‘-rJ You can use the user configuration section of the supervisory flash
N : enpheral prefemed conne to store the public device address for mass production.
i SecUrty
Device name: Find Me Target
Appearance: [Generic Keyring hd
Attribute MTU size (bytes): 23 :
Link: = T 27 =
Link: layer max R payload size (bytes): |27 =
Adv/Scan TX power level {dBm):
1 L 4 Connection TX power level (dBm): 1] -
N Restore Defaults

= JCm e

Figure 39. BLE Component GAP Advertisement Settings
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Figure 40. BLE Component GAP Advertisement Packet
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Figure 41. BLE Component GAP Scan Response Packet
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Figure 42. BLE Component GAP Security Settings

[ Configure 'BLE' m‘
MName: BLE
General [ Profile: GAP Settings ||| L2CAF Settings ]/Advanced ]’ Built-in 4 b
B(Paznn:r?elml role Scan response data settings: Scan response packet:
Advertisement settings Name Walue Description Walue Index | +
iesmeni-pesies Local Name =-AD Data 1: <<Local Name>>
- Local nsme | Complete - i Langth oOF  |[0]
TX Power Level [} <<Local Name>> 009 [1
L Value (dBm) |D = B 46 [21
| Slave C Interval Range = =69 [31
| Service UUID -’ xEE [4]
| Service Solicitati - (xB4 [51
+ | Service Data 020 [6] E
=+ | Service Manager TK Value M 4D |[7]
Appearance e s 8]
i Data Generic Keyring HD 020 [
| Public Target Address = (xB4 [101
W - | Random Target Address ~'g' x61 [111
[+ | Advertising Interval - 72 [12]
+| | LE Bluetooth Device Address - =67 [13]
- | LE Rele el =65 [14] —
G M Specific Data i) 074 [15]
- AD Data 2: <<TX Power Level>=
- Length =02 [16]
A (L) D [E}-<<TK Power Levels> [0x04  [[17]
BT I T
| o o I [ om ]|
s

Figure 43. BLE Component Profiles Configuration
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10. Rename the LEDs (LED_1, LED_2, and LED_3) as shown in steps 13 through 15.
11. Double-click LED_1 and rename it as “Disconnect_LED” as shown in Figure 44.
Figure 44. Disconnection LED Configuration

Configure ‘cy_pins’

Mame: Disconnect_LED
q b

_/ml\‘lapping ]/Cloddng }/Built—in ]
| X B+ ¢|8 %|

Number of pins: |1
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o | Type Drive mode Initial drive state:
[ Analog Strong drive v High (1) v
[] Digital input Via Min. supply voltage:
+| HW connection
Digital output [] Hot swap
] HW connection
[] Output enable g: Fin
[] Bidirectional

[] Bdemal teminal

12. Double-click LED_2 and rename is as “Advertising_LED” with HW Connection deselected and Initial drive state set
to “High(1),” as shown in Figure 45. These pins will be used to drive the BLE advertising and disconnection state
indicator LEDs. The LEDs on the BLE Pioneer Kit are active LOW; that is, the high pin-drive state turns off the LEDs

and the low pin-drive state turns them on.
Figure 45. Advertising LED Configuration
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13. Double-click LED_3 and rename it as “Alert_LED” with HW Connection deselected and Initial drive state set to

“High(1),” as shown in Figure 46.

Figure 46. Alert LED Configuration
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14. After completing the schematic configuration, your design should look similar to Figure 47.
Figure 47. Schematic Configuration
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Note The blue dotted lines, the LED symbols, and resistor symbols shown in Figure 47 are off-chip PSoC Creator
Components that are present only for descriptive purposes and are not required for the functioning of your design.
You can add off-chip Components to your design by dragging and dropping the required off-chip Components on to
your project schematic page from PSoC Creator’s off-chip Component Catalog.
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15. Open the file My_First EZ-BLE_Design.cydwr (Design-Wide Resources) file from Workspace Explorer and click
the Pins tab. You can use this tab to select the device pins for the outputs (Advertising_LED, Disconnect_LED,
and Alert_LED). Figure 48 shows the pin configuration to connect the Advertising_LED, Disconnect LED, and
Alert_LED pins to the green LED, red LED, and blue LED on the BLE Pioneer Kit respectively.

Figure 48. Pin Selection
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If you are using your own board or a development kit with no LEDs, select the appropriate pins. You can

connect external LEDs to the selected pins, as Figure 22 shows.

16. Select Generate Application from the Build menu. Notice in the Workspace Explorer window that
PSoC Creator automatically generates source code files for the BLE and Digital Output Pin Components, as

Figure 49 shows.

Figure 49. Generated Source Files
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9.

~

Part 2: Write the Firmware
Four main firmware blocks are required for designing BLE standard Profile applications using PSoC Creator:

m  System initialization
m  BLE stack event handler
m  BLE service-specific event handler

= Main loop and low-power implementation

The following sections discuss these blocks with respect to the design that you configured in Part 1: Configure the
Design.

9.4.1 System Initialization
When the EZ-BLE PRoC Module is reset, the firmware first performs the system initialization, which includes enabling
global interrupts and enabling other Components used in the design. After the system is initialized, the firmware
initializes the BLE Component, which internally initializes the complete BLE subsystem.

As a part of the BLE Component initialization, you must pass the event-handler function, which will be called by the
BLE stack to notify pending events. The BLE stack event handler shown in Code 2 is registered as a part of the BLE
initialization. If the BLE Component initializes successfully, the firmware registers another event handler for the IAS-
specific events and switches control to the main loop.

Figure 50 and Code 1 show the flow chart and the firmware source code for system initialization. Note that in Code 1,
the trim value for the 24-MHz crystal oscillator integrated on the EZ-BLE PRoC Module is provided (shown in the red
box in Code 1). This value provides optimal crystal performance for the EZ-BLE PRoC Module. It is not
recommended to change this value. For the optimal trim value for other EZ-BLE Modules, see the module datasheet.
Refer to the datasheet to verify the appropriate trim value for your EZ-BLE Module.
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Figure 50. System Initialization Flow Chart
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Code 1. System Initialization Firmware
#include <Project.h>
#define LED ON (0u)
#define LED OFF (1u)
#define NO_ ALERT (Ou)
#define MILD ALERT (1u)
#define HIGH ALERT (2u)
#define LED TOGGLE TIMEOUT (100u)
(#define CAPACITOR TRIM_VALUE 0x00003FFA |

uint8 alertlLevel;

int main ()

{
CYBLE API RESULT T apiResult;
CyGlobalIntEnable;

apiResult = CyBle Start(StackEventHandler);
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if (apiResult != CYBLE_ERROR OK)

—_~

/* BLE stack initialization failed, check your configuration */
CYASSERT (0) ;

-

CyBle IasRegisterAttrCallback (IasEventHandler);

9.4.2 BLE Stack Event Handler
The BLE stack within the BLE Component generates events to provide the BLE interface status and data to the
application firmware through the BLE stack event handler registered by you. The event handler must handle a few
basic events from the stack, such as device connection and stack on, and configure the stack accordingly to establish
and maintain the BLE link. For the Find Me Target application that you are creating, the BLE stack event handler
must process all the events described in Table 5. The flow chart and the firmware for handling BLE stack events are
shown in Figure 51 and Code 2.

Table 5. BLE Stack Events

BLE Stack Event Name Event Description Event Handler Action
CYBLE_EVT_STACK_ON BLE stack initialization Start advertisement and
completed successfully. reflect the advertisement
state on the LED.
CYBLE_EVT_GAP_DEVICE_DISCONNECTED BLE link with the peer Restart advertisement and
device is disconnected. reflect the advertisement
state on the LED.
CYBLE_EVT_GAP_DEVICE_CONNECTED BLE link with the peer Update the BLE link state on
device is established. the LED.

CYBLE_EVT_GAPP_ADVERTISEMENT_START_STOP | BLE stack advertisement Configure the device in Stop
start/stop event. mode if the advertisement
has timed out.
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Figure 51. BLE Stack Event Handler Flow Chart
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Code 2. BLE Stack Event Handler Firmware

void StackEventHandler (uint32 event, void *eventParam)

{

CYBLE BLESS CLK CFG_PARAMS T clockConfig;

switch (event)

{
/* Mandatory events to be handled by Find Me Target design */

case CYBLE EVT STACK ON:
/* load capacitors on the ECO should be tuned and the tuned value

* must be set in the CY SYS XTAL BLERD BB XO CAPTRIM REG */
CY SYS XTAL BLERD BB XO CAPTRIM REG = CAPACITOR TRIM VALUE;
/* Get the configured clock parameters for BLE sub-system */
CyBle GetBleClockCfgParam(&clockConfiq) ;
case CYBLE EVT GAP DEVICE DISCONNECTED:

/* Start BLE advertisement for 30 seconds and update link
* status on LEDs */
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CyBle GappStartAdvertisement (CYBLE ADVERTISING FAST) ;
Advertising LED Write (LED_ON) ;
alertLevel = NO ALERT;

break;

case CYBLE EVT GAP DEVICE CONNECTED:
/* BLE link is established */
Advertising LED Write (LED OFF);
Disconnect LED Write (LED OFF);
break;

case CYBLE EVT GAPP ADVERTISEMENT START STOP:
if (CyBle GetState() == CYBLE STATE DISCONNECTED)
{
/* Advertisement event timed out, go to low power
* mode (Stop mode) and wait for device reset
* event to wake up the device again */
Advertising LED Write (LED OFF);
Disconnect LED Write (LED ON);
CySysPmSetWakeupPolarity (CY PM STOP WAKEUP ACTIVE HIGH);
CySysPmStop () ;

/* Code execution will not reach here */

}

break;

default:
break;

9.4.3

BLE Service-Specific Event Handler

The BLE Component also generates events corresponding to each of the Services supported by your design. For the
Find Me Target application that you are creating, the BLE Component will generate IAS events that will let the
application know if the Alert Level Characteristic is updated with a new value. The flow chart and the firmware for
handling BLE IAS events are shown in Figure 52 and Code 3 respectively.

Figure 52. BLE IAS Event Handler Flow Chart
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Code 3. BLE IAS Event Handler Firmware

void IasEventHandler (uint32 event, void *eventParam)
{
/* Alert Level Characteristic write event */
if (event == CYBLE EVT IASS WRITE CHAR CMD)
{
/* Read the updated Alert Level value from the GATT database */
CyBle IassGetCharacteristicValue (CYBLE IAS ALERT LEVEL,
sizeof (alertLevel), &alertlLevel);

—

9.4.4 Main Loop and Low-Power Implementation
The main loop firmware in your design must periodically service the BLE stack-processing event, update the blue
alert LED state per the IAS Alert Level Characteristic value, and configure the BLESS block and the EZ-BLE PRoC
Module system into low-power mode between consecutive BLE advertisement and connection intervals. For more
information on power management, see the application note AN92584. The main loop flow chart and the firmware are
shown in Figure 53 and Code 4.

Figure 53. Firmware Main Loop Flow Chart
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Code 4. Main Loop Firmware

for(;;)

{
static uint8 toggleTimeout = 0;
CYBLE BLESS STATE T blessState;
uint8 intrStatus;

/* Single API call to service all the BLE stack events. Must be
* called at least once in a BLE connection interval */

CyBle ProcessEvents();

/* Update Alert Level value on the blue LED */
switch (alertLevel)

{
case NO_ALERT:
Alert LED Write (LED OFF);
break;

case MILD ALERT:

toggleTimeout++;

if (toggleTimeout == LED TOGGLE TIMEOUT)

{
/* Toggle alert LED after timeout */
Alert LED Write(Alert LED Read() "~ 0x01);
toggleTimeout = 0;

}

break;

case HIGH ALERT:
Alert LED Write (LED_ON);
break;

}

/* Configure BLESS in Deep-Sleep mode */
CyBle_EnterLPM (CYBLE_BLESS_DEEPSLEEP) ;

/* Prevent interrupts while entering system low power modes */
intrStatus = CyEnterCriticalSection();

/* Get the current state of BLESS block */
blessState = CyBle GetBleSsState();

/* If BLESS is in Deep-Sleep mode or the XTAL oscillator is turning on,

* then PRoC BLE can enter Deep-Sleep mode (1.3uA current consumption)
if (blessState == CYBLE BLESS STATE ECO ON ||
blessState == CYBLE BLESS STATE DEEPSLEEP)

{
CySysPmDeepSleep () ;

}
else if (blessState != CYBLE BLESS STATE EVENT CLOSE)

{
/* If BLESS is active, then configure PRoC BLE system in
* Sleep mode (~1.6mA current consumption) */
CySysPmSleep () ;

*/
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}
else
{
/* Keep trying to enter either Sleep or Deep-Sleep mode */
}

CyExitCriticalSection (intrStatus);

/* BLE link layer timing interrupt will wake up the system from Sleep
* and Deep-Sleep modes */

After including the above code snippets in the correct order, go to Build > Clean and Build your project to compile
the firmware. Appendix E details the complete main.c firmware.

9.

ol

Part 3: Program the Device

This section shows how to program the EZ-BLE PRoC Module Evaluation Board. If you are using a development kit
with a built-in programmer (the BLE Pioneer Kit, for example), connect the kit board to your computer using the USB
cable. For other kits, see the kit guide.

Note: The source project for this design is located on the AN96841 web page.

If you are developing on your own hardware, you need a hardware debugger; for example, a Cypress CY8CKIT-002
MiniProg3. In PSoC Creator, choose Debug > Select Debug Target, as Figure 54 shows.

Figure 54. Selecting Debug Target
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1. Inthe Select Debug Target dialog box, click Port Acquire, and then click Connect, as Figure 55 shows. Click
OK to close the dialog box.
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Figure 55. Connecting to a Device
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If you are using your own hardware, make sure the Port Setting configuration in the Select Debug Target
window for your programming hardware is configured per your setup.

2. In PSoC Creator, choose Debug > Program to program the device with the project, as Figure 56 shows.

Figure 56. Programming the Device
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3. You can view the programming status on the PSoC Creator status bar (lower left corner of the window), as
Figure 57 shows.
Figure 57. Programming Status
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This section describes how to test your BLE design using the CySmart mobile apps and PC tool. The setup for testing

your design using the BLE Pioneer Kit is shown in Figure 12.

Part 4: Test Your Design
Turn on Bluetooth on your iOS or Android device.
Launch the CySmart app. Press the reset switch on the BLE Pioneer Kit to start BLE advertisements from your

Pull down the CySmart app home screen to start scanning for BLE Peripherals. Your device will now appear in

the CySmart app home screen. Select your device to establish a BLE connection.

1.
2.
design.
3.
4. Select the “Find Me” Profile from the carousel view.
5. Select one of the Alert Level values on the Find Me Profile screen and observe the state of the LED on your
device change per your selection.
7. A step-by-step configuration screenshot of the CySmart mobile app is shown in Figure 58 and Figure 59.
Figure 58. Testing with CySmart iOS App
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Figure 59. Testing with CySmart Android App
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Similar to the CySmart mobile app, you can also use the CySmart Host Emulation Tool on a PC to establish a BLE
connection with your design and perform read or write operations on BLE Characteristics.

1. Connect the BLE Dongle to your Windows machine. Wait for the driver installation to complete.

2. Launch the CySmart Host Emulation Tool; it automatically detects the BLE Dongle. Click Refresh if the BLE
Dongle does not appear in the Select BLE Dongle Target pop-up window. Click Connect, as shown in Figure

60.
Figure 60. CySmart BLE Dongle Selection
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3. Select Configure Master Settings and restore the values to the default settings, as shown in Figure 61.
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Figure 61. CySmart Master Settings Configuration
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4. Press the reset switch on the BLE Pioneer Kit to start BLE advertisements from your design.

5. On the CySmart Host Emulation Tool, click Start Scan. Your device name should appear in the Discovered
devices list, as shown in Figure 62.

Figure 62. CySmart Device Discovery
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6. Select your device and click Connect to establish a BLE connection between the CySmart Host Emulation Tool
and your device, as shown in Figure 63.

Figure 63. CySmart Device Connection
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Once connected, discover all the Attributes on your design from the CySmart Host Emulation Tool, as shown in
Figure 64.

Figure 64. CySmart Attribute Discovery
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8. Write a value of 0, 1, or 2 to the Alert Level Characteristic under the Immediate Alert Service, as Figure 65
shows. Observe the state of the LED on your device change per your Alert Level Characteristic configuration.

Figure 65. Testing with CySmart Host Emulation Tool
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9.7 Design Source

The functional PSoC Creator project for the BLE example design described in this application note is distributed on
the application note web page. See the AN96841 web page to download this complete design.

This design uses GPIOs for three LEDs to indicate different states, a push button switch (SW1 Reset on CY8CKIT-
042-BLE) for wake-up from Stop mode, and a BLE subsystem to enable the ‘Find Me’ profile through the BLE
protocol. The schematic for the design from PSoC Creator is shown in Figure 47.
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10.1

10.2

10.3

10.4

10.5

10.6

10.7

10.8

Learning Resources

This section provides a list of EZ-BLE Module learning resources that can help you to get started and develop
complete applications with your EZ-BLE Module. You can also use the Document Manager in PSoC Creator to view
these resources. To open the Document Manager, choose the Help > Document Manager.

EZ-BLE Module Datasheet

The EZ-BLE Module datasheets list the features, pinouts, device-level specifications, and fixed-function peripheral
electrical specifications of the EZ-BLE Modules.

PRoC BLE Device Datasheet

PRoC BLE datasheets lists the features, pinouts, device-level specifications, and fixed-function peripheral electrical
specifications of all PRoC BLE devices. The PRoC BLE device is available in 128-KB and 256-KB flash options.
Datasheets for each of the PRoC BLE devices can be found at the below links:

m  PRoC BLE 128-KB Flash device datasheet
m PRoC BLE 256-KB Flash device datasheet

PSoC 4 BLE Device Datasheet

PSoC 4 BLE datasheets lists the features, pinouts, device-level specifications, and fixed-function peripheral electrical
specifications of all PSoC 4 BLE devices. The PSoC 4 BLE device is available in 128-KB and 256-KB flash options.
Datasheets for each of the PSoC 4 BLE devices can be found at the below links:

m  PSoC 4 BLE 128-KB Flash device datasheet
m  PSoC 4 BLE 256-KB Flash device datasheet

PRoC BLE Technical Reference Manual

The PRoC BLE Technical Reference Manual (TRM) describes the PRoC BLE device functionality in detail, with

register-level descriptions. The document is divided into two parts: the Architecture TRM and the Register TRM.

PSoC 4 BLE Technical Reference Manual

The PSoC 4 BLE Technical Reference Manual (TRM) describes the PSoC 4 BLE device functionality in detail, with

register-level descriptions. The document is divided into two parts: the Architecture TRM and the Register TRM.

Learning PSoC Creator

Visit the PSoC Creator home page to download the latest version of PSoC Creator.

Launch PSoC Creator and navigate to the following items:

®  Simple Component example projects: Choose File > Open > Example projects. These example projects
demonstrate how to configure and use PSoC Creator Components.

m  System Reference Guide: Choose Help > System Reference > System Reference Guide. This guide lists
and describes the system functions provided by PSoC Creator.

m  Component datasheets: Right-click a Component and select “Open Datasheet.”

Application Notes

Application notes assist you with understanding specific features of the device for designing your PSoC application.
For a complete list, visit Cypress BLE application notes.

Technical Support

If you have any questions, our technical support team is happy to assist you. You can create a support request by
visiting Cypress Technical Support.

If you are in the United States, you can talk to our technical support team by calling our toll-free number: +1-800-541-
4736. You can also use the following support resources if you need quick assistance.

m  Self-help

m | ocal sales office locations
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11  Summary

This application note explored the EZ-BLE Module solution, architecture, development tools, host board placement
and orientation, and production manufacturing. EZ-BLE Modules are fully integrated BLE solutions that allow rapid
development and production release for customer applications. The core of the EZ-BLE Modules is the PRoC BLE
and PSoC 4 BLE ICs, providing a programmable embedded system-on-chip, integrating the BLE radio, configurable
analog and digital peripheral functions, memory, and an ARM Cortex-MO microcontroller. EZ-BLE Modules are
available in multiple options to service the needs of any customer application.

12  Related Application Notes

e AN91445 — Antenna Design Guide

AN94020 — Getting Started with PRoC® BLE

e AN91267 — Getting Started with PSoC® 4 BLE

e AN95089 — PSoC® 4/PRoC™ BLE Crystal Oscillator Selection and Tuning Techniques
e AN91162 — Creating a BLE Custom Profile

e AN91184 — PSoC 4 BLE - Designing BLE Applications

e AN92584 — Designing for Low Power and Estimating Battery Life for BLE Applications
e ANB85951 — PSoC® 4 CapSense® Design Guide

About the Author
Name: David Solda (DSO)

Title: Business Unit Director

Background: David Solda has a BS in Computer/Electrical Engineering, a BS in Mathematics, and an MBA from
Santa Clara University, California.
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13  Appendix A: Cypress Terms of Art

This section lists the most commonly used terms that you might hear while working with Cypress’s PSoC family of
devices.

PSoC — PSoC is a programmable, embedded design platform that includes a CPU, such as the 32-bit ARM Cortex-
MO, with both analog and digital programmable blocks. It accelerates embedded system design with reliable, easy-to-
use solutions, such as touch sensing and enables low-power designs.

PRoC BLE — PRoC BLE is a 32-bit, 48-MHz ARM Cortex-M0 BLE solution with CapSense, 12-bit ADC, four timers,
counters, pulse-width modulators (TCPWM), thirty-six GPIOs, two serial communication blocks (SCBs), LCD, and
I2S. PRoC BLE includes a royalty-free BLE stack compatible with Bluetooth 4.1 and provides a complete,
programmable, and flexible solution for HID, remote controls, toys, beacons, and wireless chargers. In addition to
these applications, PRoC BLE provides a simple, low-cost way to add BLE connectivity to any system.

PSoC 4 BLE — A PSoC 4 IC with an integrated BLE radio that includes a royalty-free BLE protocol stack compatible
with the Bluetooth 4.1 specification.

EZ-BLE" PRoC Module (EZ-BLE PRoC) — EZ-BLE PRoC Module is a fully integrated, fully certified, 10 mm x 10
mm x 1.8 mm, programmable, Bluetooth Smart or Bluetooth Low Energy (BLE) module designed for ease-of-use and
reducing time-to-market. It contains Cypress’s PRoC BLE chip, two crystals, chip antenna, shield and passive
components. EZ-BLE PRoC Module provides a simple and low cost way to add a microcontroller, CapSense touch
controller and Bluetooth Smart connectivity to any system.

EZ-BLE" PSoC Module (EZ-BLE PSoC) — An integrated, easy-to-use, fully certified Bluetooth Smart module
designed to reduce time-to-market and development cost. Contains PSoC 4 BLE, two crystals, an antenna and
passive components

PSoC Creator — PSoC 3, PSoC 4, and PSoC 5LP Integrated Design Environment (IDE) software that installs on
your PC and allows concurrent hardware and firmware design of PSoC systems, or hardware design followed by
export to other popular IDEs.

Components — Free embedded ICs represented by an icon in PSoC Creator software. These are used to integrate
multiple ICs and system interfaces into one PSoC Component that are inherently connected to the MCU via the main
system bus. For example, the BLE Component creates Bluetooth Smart products in minutes. Similarly, you can use
the Programmable Analog Components for sensors.

BLE Component — A Component that creates Bluetooth Smart products in minutes. Includes a Component
Configuration Tool that makes the complex BLE Protocol Stack and Profiles simple to implement with a GUI

Component Configuration Tool — Simple graphical user interface in PSoC Creator that is included in each
Component. It is used to customize the Component parameters and is accessed by right-clicking a Component.

PSoC Programmer — PSoC Programmer is a flexible, integrated programming application for programming PSoC
devices. PSoC Programmer is integrated with PSoC Creator to program PSoC 3, PSoC 4, PRoC, and PSoC 5LP
designs.

MiniProg3 — Programming hardware for development purposes that can be used to program PSoC devices on your
custom board or PSoC development kits that do not support a built-in programmer.

Timer/Counter/PWM (TCPWM) Block — A PSoC Programmable Digital Block that is configurable as a 16-bit Timer,
Counter, PWM or quadrature decoder.

Programmable Analog Block — A hardware block that is configured using PSoC Components to create
Analog Front Ends (AFEs), signal conditioning circuits with opamps and filters. Includes Continuous Time Blocks,
analog-to-digital converters (ADCs) and digital-to-analog converters (DACS).

Continuous Time Block (CTB) — A Programmable Analog Block that is used to implement continuous time
analog circuits such as opamps and programmable gain amplifiers (PGAS)

Programmable Digital Block — A hardware block that is configured using PSoC Components to implement
custom digital peripherals and glue logic Includes Universal Digital Blocks, Serial Communication Blocks (SCBs) and
TCPWMs.
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Universal Digital Block (UDB) — A PSoC Programmable Digital Block that contains two programmable logic devices
(PLDs), one programmable datapath with an arithmetic logic unit (ALU), one status register and one control register.
Configured in PSoC Creator using PSoC Components, or with the graphical UDB editor or using Verilog code

Serial Communication Block (SCB) — A PSoC Programmable Digital Block that is configurable as a UART, SPI or
12C interface.

CapSense® - Cypress’s third-generation touch-sensing user interface solution that “just works” in noisy environments
and in the presence of water. The industry’s No. 1 solution in sales by 4x over No. 2.

Component Configuration Tools — Simple graphical user interfaces in PSoC Creator embedded in each
Component. Used to customize Component parameters as shown to the right.
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14  Appendix B: EZ-BLE Module Product Details

Appendix B provides detailed information on each of the respective EZ-BLE Modules. The information contained for
each module part number includes the following:

m  Physical image for each EZ-BLE Module marketing part number
®  Pinout and functionality for each EZ-BLE Module marketing part number
m  Recommended host PCB layout footprint for each EZ-BLE Module marketing part number

®  Recommended additional clearance area for each EZ-BLE Module marketing part number
To jump to your specific EZ-BLE Module, click the marketing part number in the below list:

EZ-BLE PRoC Modules

= CYBLE-022001-00
m  CYBLE-01201X-X0 (CYBLE-012011-00 and CYBLE-012012-10)
= CYBLE-222005-00

m  CYBLE-212019-00
EZ-BLE PSoC Modules

= CYBLE-014008-00
= CYBLE-214009-00

14.1 EZ-BLE PRoC Part Number Details

14.1.1 CYBLE-022001-00
Figure 66 shows a physical picture of the CYBLE-022001-00 EZ-BLE PRoC module.

Figure 66. CYBLE-022001-00 Module Top View (with and without Shield) and Side View
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10.0 mm

Chip Antenna

For more details on this module’s dimensions, external component connections, and module placement
recommendations, see the CYBLE-022001-00 datasheet specification.
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Pinout and Functionality

The CYBLE-022001-00 module is designed to mount as a component on an end-product PCB. Only a portion of the
available 1/0 of the PRoC BLE silicon device is exposed on the CYBLE-022001-00 module in order to minimize the
module footprint size. The CYBLE-022001-00 module contains 21 connections on the bottom side of the module.
Figure 67 details the bottom side connections available on the CYBLE-022001-00 module.

Figure 67. CYBLE-022001-00 Module Bottom View (Seen from Bottom)
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18 [_BL.4
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EENG

21
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A list of the available I/Os and supported functionality for each 1/0 of the CYBLE-022001-00 is shown in Table 6.
Table 6. CYBLE-022001-00 Module Available Connections and Functionality

S(L\f(cj)gru:?ead PS(I)IrIthlnn : Functlonallt.y : :
Number UART | SPI 12C |TCPWM®| CapSense |[LCD Drive| WCO Out [ECO_OUT SWD |GPIO

1 GND Ground Connection
2 P4[1] CTS | MISO Yes Sensor/Crank Yes Yes
3 P5[1] X SCLK | SCL Yes Sensor Yes Yes Yes
4 P5[0] RX SS SDA Yes Sensor Yes Yes
5 VDDR Radio Power Supply 1.9 Vto 5.5V
6 P1[6] RTS SS Yes Sensor Yes Yes
7 PO[7] CTS | SCLK Yes Sensor Yes SWDCLK® | Yes
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Sc')\fggrulLead PS(;IrIthPn Functionality
Number UART | SPI I2C | TCPWM®| CapSense |LCD Drive| WCO Out [ECO_OUT’| SwbD [GPIO®
8 PO[4] RX MOSI | SDA Yes Sensor Yes Yes Yes
9 PO[5] TX MISO | SCL Yes Sensor Yes Yes
10 GND Ground Connection
11 PO[6] RTS SS Yes Sensor Yes SWDIO® | Yes
12 P1[7] CTS | SCLK Yes Sensor Yes Yes
13 VDD Digital Power Supply Input 1.71 to 5.5V
14 XRES External Reset Hardware Connection Input
15 P3[5] TX SCL Yes Sensor Yes Yes
16 P3[4] RX SDA Yes Sensor Yes Yes
17 P3[7] CTS | MISO Yes Sensor Yes Yes Yes
18 P1[4] RX MOSI | SDA Yes Sensor Yes Yes
19 P1[5] TX MISO | SCL Yes Sensor Yes Yes
20 P3[6] RTS Yes Sensor Yes Yes
21 P4[0] | RTS | MOSI Yes Cwmop Yes Yes
Notes

® Timer, counter, pulse-width modulator (PWM); configurable as 16-bit timer, counter, PWM blocks
" External Crystal Oscillator Output from the device/module
8 General Purpose Input/Output

® SDWCLK and SWDIO connections can be multiplexed as the functional options listed in each of the respective rows and can be
used for programming without the need to reconfigure the device I/O.
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Host Recommended PCB Layout

To assist in the host PCB layout design for the CYBLE-022001-00, Cypress provides three host PCB landing pattern
reference drawings in Figure 68, Figure 69, and in Figure 70, and Table 7. Figure 68 provides a dimensioned view of
the host PCB layout. Figure 69 provides the location to the center edge of each solder pad relative to the origin of the
module (lower left PCB outline). Figure 70 and Table 7 provides the location to each solder pad center location for the
host PCB layout. Dimensions shown are in mm unless otherwise stated.

Figure 68. Host Board Required PCB Layout Pattern (Dimensioned View)
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Note: Pad length shown includes overhang of the host pad beyond the module pad outline. The minimum recommended pad length on the host PCB is
0.91 mm.

Figure 69. Host Board Required PCB Layout Pattern: To Pad Center Edge Relative to Origin
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Figure 70. Host Board Required PCB Layout Pattern Table 7. Location to Pad Center from Origin
To Pad Center Relative to Origin (dimensions in mm and mils)
2 Solder Pad Location (X,Y) from | Location (X,Y) from
X (Center of Pad) Origin (mm) Origin (mils)
1 (0.26, 1.64) (10.24, 64.57)
00— NNy —— <1010 2 (0.26, 2.41) (10.24, 94.88)
PADIS 3 (0.26, 3.17) (10.24, 124.80)
4 (0.26, 3.93) (10.24, 154.72)
BhEE 5 (0.26, 4.69) (10.24, 184.65)
PADS 6 (0.81, 9.74) (31.89, 383.46)
DI — 7 (1.57,9.74) (61.81, 383.46)
PAD]—— 8 (2.34, 9.74) (92.13, 383.46)
©,0 RS 9 (3.10, 9.74) (122.05, 383.46)
e 10 (3.86, 9.74) (151.97, 383.46)
11 (4.62,9.74) (181.89, 383.46)
DETAIL A
PAD CENTER 12 (5.38, 9.74) (211.81, 383.46)
DEFINITION 13 (6.15, 9.74) (242.13, 383.46)
0.455 14 (6.91, 9.74) (272.05, 383.46)
MINIMUM \ 15 (7.67, 9.74) (301.97, 383.46)
B A CAD CENTER 16 (8.43, 9.74) (331.89, 383.46)
17 (9.19, 9.74) (361.81, 383.46)
e—=1—0.455 18 (9.75, 8.50) (383.86, 334.65)
19 (9.75, 7.74) (383.86, 304.72)
20 (9.75, 6.98) (383.86, 274.80)
21 (9.75, 6.22) (383.86, 244.88)

Figure 71 below details additional host board keep out area to achieve optimal RF performance with the CYBLE-
022001-00 module (denoted in blue hatched area).

Figure 71. Host Board Additional Keep Out Area for Optimal RF Performance

MODULE OUTLINE

10.00 r va
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0.00,0.00 :~i, m:m : 2. THE RECOMMENDED PLACEMENT OF THE
| G B BLE MODULE IS IN THE CORNER OF THE
| 1 HOST BOARD WITH THE ANTENNA FACING
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14.1.2 CYBLE-01201X-X0

The CYBLE-01201X-X0 is a cost-optimized platform designed to minimize system cost for applications that can utilize
a larger module form factor. This platform is available in a fully certified and qualified option (CYBLE-012011-00), as
well as a subset device that is not certified nor qualified with Bluetooth SIG (CYBLE-012012-10). The CYBLE-
012011-00 and CYBLE-012012-10 are pin-for-pin compatible with each other. The CYBLE-012012-10 does not come
with the RF metal shield on the top side of the module.

The mechanical drawing and reference layout information contained in this section is identical for both CYBLE-
012011-00 and CYBLE-012012-10 modules.

Figure 72 shows a physical picture of the CYBLE-012011-00 EZ-BLE PRoC module.
Figure 72. CYBLE-012011-00 Module Top View (with and without Shield)

Top View of EZ-BLE Module Without Shield Top View of EZ-BLE Module With Shield

Shield FOOIPINING ¥
H=1.20 mm

19.2 mm

L Y Ty

)
)
)
}
For more details on this module’s dimensions, external component connections, and module placement
recommendations, see the CYBLE-01201X-X0 datasheet specification.

S—— | Face Antenna

14.5 mm

Pinout and Functionality

The CYBLE-01201X-X0 module is designed to mount as a component on an end-product PCB. Only a portion of the
available 1/0 of the PRoC BLE silicon device is exposed on the CYBLE-01201X-X0 module in order to minimize the
module footprint size. The CYBLE-01201X-X0 module contains 31 connections on the bottom side of the module.
Figure 73 details the bottom side connections available on the CYBLE-01201X-X0 module.
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22

31

Figure 73. CYBLE-01201X-X0 Module Bottom View
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A list of the available 1/0s and supported functionality for each I/O of the CYBLE-01201X-X0 is shown in Table 8.
Table 8. CYBLE-01201X-X0 Module Available Connections and Functionality

Functionality

Module [Silicon
Solder Pad| Port

Number | Pin | UART SPI I2C [TCPWM'| CapSense l'D‘r(i:\i Vg)ﬁ? ECO OUTY[ SWD |SARMUX| OPAMP |LPCOMP| GPIO™
1 GND Ground Connection
1 XRES External Reset Hardware Connection Input
2 P4[0] RTS MOSI Yes Cwmop Yes Yes
3 P3[7] CRS Yes Sensor Yes Yes Yes Yes
4 P3[6] RTS Yes Sensor Yes Yes Yes
5 P3[5] TX SCL Yes Sensor Yes Yes Yes
6 P3[4] RX SDA Yes Sensor Yes Yes Yes
7 P3[3] CTS Yes Sensor Yes Yes Yes
8 P3[2] RTS Yes Sensor Yes Yes Yes
9 P2[6] Sensor Yes Yes
10 VREF Reference Voltage Inputs (Optional)
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Module |Silicon ANEHCE
Solder Pad| Port
Number | Pin | UART SPI I2C [TCPWM'| CapSense I'D‘E\Z V(\gi? ECO_OUTY[ SWD |SARMUX| OPAMP |LPCOMP| GPIO™
11 P2[4] Sensor Yes Yes
12 P2[3] Sensor Yes Yes Yes
13 P2[2] SS Sensor Yes Yes
14 P2[0] SS Sensor Yes Yes
15 VDD Digital and Analog Power Supply Input 1.71 to 5.5V
16 P1[7] CTS SCLK Yes Sensor Yes Yes
17 P1[6] RTS SS Yes Sensor Yes Yes
18 P1[5] X MISO SCL Yes Sensor Yes Yes
19 P1[4] RX MOSI | SDA Yes Sensor Yes Yes
20 P1[0] Yes Sensor Yes Yes Yes
21 PO[4] RX MOSI | SDA Yes Sensor Yes Yes Yes
22 PO[5] X MISO SCL Yes Sensor Yes Yes
23 PO[7] | CTS SCLK Yes Sensor Yes SWDCLK® Yes
24 Po[6] | RTS SS Yes Sensor Yes swpIo® Yes
25 GND Ground Connection
26 GND Ground Connection
27 GND Ground Connection
28 GND Ground Connection
29 VDDR Radio Power Supply 1.9V to 5.5V
30 P5[0] RX SS SDA Yes Sensor Yes Yes
31 P5[1] TX SCLK | SCL Yes Sensor Yes Yes Yes
Notes

Timer, counter, pulse-width modulator (PWM); configurable as 16-bit timer, counter, PWM blocks

" External Crystal Oscillator Output from the device/module

'2 General Purpose Input/Output

¥ SDWCLK and SWDIO connections can be multiplexed as the functional options listed in each of the respective rows and can be
used for programming without the need to reconfigure the device 1/O.

Host Recommended PCB Layout

To assist in the host PCB layout design for the CYBLE-01201X-X0, Cypress provides three host PCB landing pattern
reference drawings in Figure 74, Figure 75, and in Figure 76, and Table 9. Figure 74 provides a dimensions view of

the host PCB layout. Figure 75 provides the location to the center edge of each solder pad relative to the origin of the
module (lower left PCB outline). Figure 76 and Table 9 provides the location to each solder pad center location for the
host PCB layout. Dimensions shown are in mm unless otherwise stated.
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Figure 74. Host Board Required PCB Layout Pattern (Dimensioned View)
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Note: Pad length shown includes overhang of the host pad beyond the module pad outline. The minimum recommended pad length on the host PCB is
1.27 mm.
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Figure 75. Host Board Required PCB Layout Pattern: To Pad Center Edge Relative to Origin
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Figure 76. Host Board Required PCB Layout Pattern
To Pad Center Relative to Origin

Table 9. Location to Pad Center from Origin
(dimensions in mm and mils)

o — Solder Pad Location (X,Y) from | Location (X,Y) from
b=t & (Center of Pad) Origin (mm) Origin (mils)
=T <L
[ ul
1 (0.39, 4.88) (15.35, 192.13)
(0,19.2> D D D D D D D D D D (14.52,19.2) 2 (0.39, 6.15) (15.35, 242.13)
PADI— [ 3 (0.39, 7.42) (15.35, 292.13)
| = PAD22
0 | 4 (0.39, 8.69) (15.35, 342.13)
| 7
5 = 5 (0.39, 9.96) (15.35, 392.13)
I L 6 (0.39, 11.23) (15.35, 442.13)
| 7
1] C 7 (0.39, 12.50) (15.35, 492.13)
DETAIL & (=) |
&= o 8 (0.39, 13.77) (15.35, 542.13)
PaDl— ] P PAD31 9 (0.39, 15.04) (15.35, 592.13)
10 (0.39, 16.31) (15.35, 642.13)
D;'“‘[-f;h (14,52, 11 (0.39, 17.58) (15.35, 492.13)
12 (2.04, 18.82) (80.31, 740.94)
13 (3.31,18.82) (130.31 , 740.94)
DETAIL A
o . 14 (4.58 ,18.82) (180.31 , 740.94)
FAaD CENTER \
DEFINITION 15 (5.85, 18.82) (230.31, 740.94)
16 (7.12,18.82) (280.31 , 740.94)
- 0,635 17 (8.39, 18.82) (330.31 , 740.94)
CMINIMUM '
— 18 (9.66 , 18.82) (380.31 , 740.94)
\“‘\-\.\_\ -~ i
~_| : 19 (10.93 , 18.82) (430.31 , 740.94)
B ———P4D CENTER
/’ e 20 (12.20, 18.82) (480.31 , 740.94)
- ~ ;
21 (13.47, 18.82) (530.31, 740.94)
SR B T 22 (14.14, 16.31) (556.69, 642.12)
23 (14.14, 15.04) (556.69, 592.12)
24 (14.14, 13.77) (556.69, 542.12)
25 (14.14, 12.50) (556.69, 492.12)
26 (14.14, 11.23) (556.69, 442.12)
27 (14.14, 9.96) (556.69, 392.12)
28 (14.14, 8.69) (556.69, 342.12)
29 (14.14, 7.42) (556.69, 292.12)
30 (14.14, 6.15) (556.69, 242.12)
31 (14.14, 4.88) (556.69, 192.12)

WWW.Cypress.com Document No.: 001-96841 Rev. *E Need support? Click here. 66


http://www.cypress.com/

PERFORM
Getting Started With EZ-BLE™ Module

Figure 77 below details additional host board keep out area to achieve optimal RF performance with the CYBLE-
01201X-X0 module.

Figure 77. Host Board Additional Keep Out Area for Optimal RF Performance
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14.1.3 CYBLE-222005-00
The CYBLE-222005-00 is drop-in compatible with the CYBLE-022001-00 module. Although the CYBLE-222005-00
includes an additional VREF connection on the module, this connection is optional and is not required to maintain the
same functionality as done with the CYBLE-022001-00. The CYBLE-222005-00 is a flash and SRAM upgrade to the
CYBLE-022001-00, moving from 128-KB flash and 16-KB SRAM to 256-KB flash and 32-KB SRAM.

Figure 78 shows a physical picture of the CYBLE-222005-00 EZ-BLE PRoC module.
Figure 78. CYBLE-222005-00 Module Top View (with and without Shield) and Side View

Shield Outline
H=1.10 mm

10.0 mm

Chip Antenna

For more details on this module’s dimensions, external component connections, and module placement
recommendations, see the CYBLE-222005-00 datasheet specification.
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Pinout and Functionality

The CYBLE-222005-00 module is designed to mount as a component on an end-product PCB. Only a portion of the
available 1/0 of the PRoC BLE silicon device is exposed on the CYBLE-222005-00 module in order to minimize the
module footprint size. The CYBLE-222005-00 module contains 22 connections on the bottom side of the module.
Figure 79 details the bottom side connections available on the CYBLE-222005-00 module.

Figure 79. CYBLE-222005-00 Module Bottom View

LO wn A O

. =] =) .
o e — —
jal] < " jal]

19 [ 22

A list of the available I/Os and supported functionality for each 1/0 of the CYBLE-222005-00 is shown in Table 10.
Table 10. CYBLE-222005-00 Module Available Connections and Functionality

S(L\fggrullr’zd PSOIII_I;:'?’Pn : Functlonallt.y _ _
Number UART | SPI 12C |TCPWM™| CapSense |LCD Drive| WCO Out |[ECO_OUT SWD |GPIO
1 GND Ground Connection
2 P4[1] CTS | MISO Yes |Sensor/Crank Yes Yes
3 P5[1] X SCLK | SCL Yes Sensor Yes Yes Yes
4 P5[0] RX SS SDA Yes Sensor Yes Yes
5 VDDR Radio Power Supply 1.9 Vto 5.5V
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S(;\flggrullazd F?(;'r't"gl"n _ Functionality _ .

Number UART | SPI I2C |TCPWM™| CapSense [LCD Drive| WCO Out |ECO_OUT SWD |GPIO
6 VREF Reference Voltage Inputs (Optional)
7 P1[6] RTS SS Yes Sensor Yes Yes
8 PO[7] | CTS |SCLK Yes Sensor Yes SWDCLK"Y| Yes
9 PO[4] RX MOSI | SDA Yes Sensor Yes Yes Yes
10 PO[5] TX MISO | SCL Yes Sensor Yes Yes
11 GND Ground Connection
12 PO[6] | RTS | SS Yes Sensor Yes SWDIOY | Yes
13 P1[7] CTS | SCLK Yes Sensor Yes Yes
14 VDD Digital Power Supply Input 1.71 to 5.5V
15 XRES External Reset Hardware Connection Input
16 P3[5] TX SCL Yes Sensor Yes Yes
17 P3[4] RX SDA Yes Sensor Yes Yes
18 P3[7] CTS | MISO Yes Sensor Yes Yes Yes
19 P1[4] RX MOSI | SDA Yes Sensor Yes Yes
20 P1[5] X MISO | SCL Yes Sensor Yes Yes
21 P3[6] RTS Yes Sensor Yes Yes
22 P4[0] | RTS | MOSI Yes Cuiop Yes Yes

Notes

“ Timer, counter, pulse-width modulator (PWM); configurable as 16-bit timer, counter, PWM blocks
'* External Crystal Oscillator Output from the device/module
'® General Purpose Input/Output

7 SDWCLK and SWDIO connections can be multiplexed as the functional options listed in each of the respective rows and can be
used for programming without the need to reconfigure the device 1/O.
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Host Recommended PCB Layout

To assist in the host PCB layout design for the CYBLE-222005-00, Cypress provides three host PCB landing pattern
reference drawings in Figure 80, Figure 81, and in Figure 82, and Table 11. Figure 80 provides a dimensions view of
the host PCB layout. Figure 81 provides the location to the center edge of each solder pad relative to the origin of the
module (lower left PCB outline). Figure 82 and Table 11 provides the location to each solder pad center location for
the host PCB layout. Dimensions shown are in mm unless otherwise stated.

Figure 80. Host Board Required PCB Layout Pattern (Dimensioned View)
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Note: Pad length shown includes overhang of the host pad beyond the module pad outline. The minimum recommended pad length on the host PCB is
0.91 mm.

Figure 81. Host Board Required PCB Layout Pattern: To Pad Center Edge Relative to Origin
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Figure 82. Host Board Required PCB Layout Pattern Table 11. Location to Pad Center from Origin
To Pad Center Relative to Origin (dimensions in mm and mils)
Solder Pad Location (X,Y) from | Location (X,Y) from
(Center of Pad) Origin (mm) Origin (mils)
1 (0.26, 1.64) (10.24, 64.57)
(10,100

2 (0.26, 2.41) (10.24, 94.88)

el 3 (0.26, 3.17) (10.24, 124.80)

4 (0.26, 3.93) (10.24, 154.72)

Palles

5 (0.26, 4.69) (10.24, 184.65)

6 (0.26, 5.45) (10.24, 214.57)

7 (0.81, 9.74) (31.89, 383.46)

8 (1.57, 9.74) (61.81, 383.46)

€0.10) 9 (2.34,9.74) (92.13, 383.46)
10 (3.10, 9.74) (122.05, 383.46)
11 (3.86, 9.74) (151.97, 383.46)
12 (4.62, 9.74) (181.89, 383.46)

DETAIL A

~ 13 5.38,9.74 211.81, 383.46
PAD CENTER | ( ) ( )
DEFINITION 14 (6.15, 9.74) (242.13, 383.46)
7 15 (6.91, 9.74) (272.05, 383.46)

0,435 |
¢CMINIMUMD i 16 (7.67,9.74) (301.97, 383.46)
17 (8.43, 9.74) (331.89, 383.46)
Pp=c —PAD CENTER

T T _ 18 (9.19, 9.74) (361.81, 383.46)
0,455 / 19 (9.75, 8.50) (383.86, 334.65)
20 (9.75, 7.74) (383.86, 304.72)
21 (9.75, 6.98) (383.86, 274.80)
22 (9.75, 6.22) (383.86, 244.88)
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Figure 83 details additional host board keep-out area to achieve an optimal RF performance with the CYBLE-222005-

00 module.
Figure 83. Host Board Additional Keep Out Area for Optimal RF Performance
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14.1.4 CYBLE-212019-00
The CYBLE-212019-00 is a cost-optimized platform designed to minimize system cost for applications that can utilize

a larger module form factor. The CYBLE-212019-00 is pin-to-pin compatible with the CYBLE-01201X-X0 modules.
The CYBLE-212019-00 is fully certified and qualified with Bluetooth SIG to the Bluetooth 4.1 specification.

Figure 84 shows a physical picture of the CYBLE-212019-00 EZ-BLE PRoC module.

Figure 84. CYBLE-212019-00 Module Top View (with and without Shield)
Top View of EZ-BLE Module With Shield

Top View of EZ-BLE Module Without Shield
- X

Shield FOOPNN g
H=1.20 mm
192 mm

---------------

I 14.5 mm I
For more details on this module’s dimensions, external component connections, and module placement

recommendations, see the CYBLE-212019-00 datasheet specification.

72

Document No.: 001-96841 Rev. *E Need support? Click here.

Www.cypress.com


http://www.cypress.com/
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A37896&f%5b2%5d=resource_meta_type%3A575

PERFORM

Getting Started With EZ-BLE™ Module

Pinout and Functionality

The CYBLE-212019-00 module is designed to mount as a component on an end-product PCB. Only a portion of the
available 1/0 of the PRoC BLE silicon device is exposed on the CYBLE-212019-00 module in order to minimize the
module footprint size. The CYBLE-212019-00 module contains 31 connections on the bottom side of the module.
Figure 85 details the bottom side connections available on the CYBLE-212019-00 module.

Figure 85. CYBLE-212019-00 Module Bottom View
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A list of the available I/Os and supported functionality for each 1/0 of the CYBLE-212019-00 is shown in Table 12.
Table 12. CYBLE-212019-00 Module Available Connections and Functionality

Module |Silicon AT
Solder Pad| Port

Number | Pin | UART | sPi | i2c [rcPwm| capsense | SC0 | W9 leco out®| swp  [sArMUX|{oPAMP [LPCOMP| GPIO®
1 GND Ground Connection
1 XRES External Reset Hardware Connection Input
2 P4[0] RTS MOSI Yes Cwmobp Yes Yes
3 P3[7] CRS Yes Sensor Yes Yes Yes Yes
4 P3[6] RTS Yes Sensor Yes Yes Yes
5 P3[5] TX SCL Yes Sensor Yes Yes Yes
6 P3[4] RX SDA Yes Sensor Yes Yes Yes
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Module |Silicon A7
Solder Pad| Port
Number | Pin | UART SPI I2C [TCPWM*| CapSense I'D‘E\i V(\gi? ECO_OUT”| SWD [SARMUX|OPAMP |LPCOMP| GPIO®
7 P3[3] CTS Yes Sensor Yes Yes Yes
8 P3[2] RTS Yes Sensor Yes Yes Yes
9 P2[6] Sensor Yes Yes
10 VREF Reference Voltage Inputs (Optional)
11 P2[4] Sensor Yes Yes
12 P2[3] Sensor Yes Yes Yes
13 P2[2] SS Sensor Yes Yes
14 P2[0] SS Sensor Yes Yes
15 VDD Digital and Analog Power Supply Input 1.71 to 5.5V
16 P1[7] CTS SCLK Yes Sensor Yes Yes
17 P1[6] RTS SS Yes Sensor Yes Yes
18 P1[5] X MISO SCL Yes Sensor Yes Yes
19 P1[4] RX MOSI | SDA Yes Sensor Yes Yes
20 P1[0] Yes Sensor Yes Yes Yes
21 PO[4] RX MOSI | SDA Yes Sensor Yes Yes Yes
22 PO[5] X MISO SCL Yes Sensor Yes Yes
23 PO[7] | CTS SCLK Yes Sensor Yes SWDCLK?* Yes
24 PO[6] | RTS SS Yes Sensor Yes SWDIO* Yes
25 GND Ground Connection
26 GND Ground Connection
27 GND Ground Connection
28 GND Ground Connection
29 VDDR Radio Power Supply 1.9V to 5.5V
30 P5[0] RX SS SDA Yes Sensor Yes Yes
31 P5[1] TX SCLK | SCL Yes Sensor Yes Yes Yes
Notes

'8 Timer, counter, pulse-width modulator (PWM); configurable as 16-bit timer, counter, PWM blocks

9 External Crystal Oscillator Output from the device/module

% General Purpose Input/Output

% SPDWCLK and SWDIO connections can be multiplexed as the functional options listed in each of the respective rows and can be
used for programming without the need to reconfigure the device I/O.
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Getting Started With EZ-BLE™ Module

Host Recommended PCB Layout

To assist in the host PCB layout design for the CYBLE-212019-00, Cypress provides three host PCB reference
drawings in Figure 86, Figure 87, and in Figure 88, and Table 13. Figure 86 provides a dimensions view of the host
PCB layout. Figure 87 provides the location to the center edge of each solder pad relative to the origin of the module
(lower left PCB outline). Figure 88 and Table 13 provide the location to each solder pad center location for the host
PCB layout. Dimensions shown are in mm unless otherwise stated.

Figure 86. Host Board Required PCB Layout Pattern (Dimensioned View)
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Note: Pad length shown includes overhang of the host pad beyond the module pad outline. The minimum recommended pad length on the host PCB is
1.27 mm.
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Figure 87. Host Board Required PCB Layout Pattern: To Pad Center Edge Relative to Origin
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Figure 88. Host Board Required PCB Layout Pattern
To Pad Center Relative to Origin

Table 13. Location to Pad Center from Origin
(dimensions in mm and mils)

o — Solder Pad Location (X,Y) from | Location (X,Y) from
b=t & (Center of Pad) Origin (mm) Origin (mils)
=T <L
[ ul
1 (0.39, 4.88) (15.35, 192.13)
(0,19.2> D D D D D D D D D D (14.52,19.2) 2 (0.39, 6.15) (15.35, 242.13)
PADI— [ 3 (0.39, 7.42) (15.35, 292.13)
| = PAD22
0 | 4 (0.39, 8.69) (15.35, 342.13)
| 7
5 = 5 (0.39, 9.96) (15.35, 392.13)
I L 6 (0.39, 11.23) (15.35, 442.13)
| 7
1] C 7 (0.39, 12.50) (15.35, 492.13)
DETAIL & (=) |
&= o 8 (0.39, 13.77) (15.35, 542.13)
PaDl— ] P PAD31 9 (0.39, 15.04) (15.35, 592.13)
10 (0.39, 16.31) (15.35, 642.13)
D;'“‘[-f;h (14,52, 11 (0.39, 17.58) (15.35, 492.13)
12 (2.04, 18.82) (80.31, 740.94)
13 (3.31,18.82) (130.31, 740.94)
DETAIL A
o . 14 (4.58 ,18.82) (180.31 , 740.94)
FAaD CENTER \
DEFINITION 15 (5.85, 18.82) (230.31, 740.94)
16 (7.12,18.82) (280.31 , 740.94)
- 0,635 17 (8.39, 18.82) (330.31 , 740.94)
CMINIMUM '
— 18 (9.66 , 18.82) (380.31 , 740.94)
\“‘\-\.\_\ -~ i
~_| : 19 (10.93 , 18.82) (430.31 , 740.94)
E———PAD CENTER |
/’ e 20 (12.20, 18.82) (480.31 , 740.94)
- ~ ;
21 (13.47, 18.82) (530.31, 740.94)
SR B T 22 (14.14, 16.31) (556.69, 642.12)
23 (14.14, 15.04) (556.69, 592.12)
24 (14.14, 13.77) (556.69, 542.12)
25 (14.14, 12.50) (556.69, 492.12)
26 (14.14, 11.23) (556.69, 442.12)
27 (14.14, 9.96) (556.69, 392.12)
28 (14.14, 8.69) (556.69, 342.12)
29 (14.14, 7.42) (556.69, 292.12)
30 (14.14, 6.15) (556.69, 242.12)
31 (14.14, 4.88) (556.69, 192.12)
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Figure 89 below details additional host board keep out area to achieve optimal RF performance with the CYBLE-
212019-00 module.

Figure 89. Host Board Additional Keep Out Area for Optimal RF Performance
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14.2 EZ-BLE PSoC Part Number Details

14.2.1 CYBLE-014008-00
Figure 90 shows a physical picture of the CYBLE-014008-00 EZ-BLE PSoC module.

Figure 90. CYBLE-014008-00 Module Top View (with and without Shield) and Side View

A

Shield Footprint e Shield
H=1.00 mm

11.0 mm

S Trace Antenna

11.0 mm
Side View of EZ-BLE PSoC Module Without Shield

T

For more details on this module’s dimensions, external component connections, and module placement
recommendations, see the CYBLE-014008-00 datasheet specification.

Pinout and Functionality

The CYBLE-014008-00 module is designed to mount as a component on an end-product PCB. Only a portion of the
available 1/0 of the PSoC BLE silicon device is exposed on the CYBLE-014008-00 module in order to minimize the
module footprint size. The CYBLE-014008-00 module contains 32 connections on the bottom side of the module.
Figure 91 details the bottom side connections available on the CYBLE-014008-00 module.
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CYBLE-014008-00 Module Bottom View

Figure 91.
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A list of the available I/Os and supported functionality for each 1/0 of the CYBLE-014008-00 is shown in Table 14.
Table 14. CYBLE-014008-00 Module Available Connections and Functionality

Module N Functionality
Solder Pad 51501 . Lco | wco . 2

Number UART | SPI 12C |[TCPWM®| CapSense Drive out ECO_OUT SWD |SARMUX| OPAMP |LPCOMP| GPIO
1 GND Ground Connection
2 P1[1] SS Yes Sensor Yes INN Yes
3 P1[0] Yes Sensor Yes Yes INP Yes
4 P1[5] TX | MISO | SCL Yes Sensor Yes INP Yes
5 PO[1] TX | MISO | SCL Yes Sensor Yes INN Yes
6 PO[7] | CTS | SCLK Yes Sensor Yes SWDCLK? Yes
7 VDD Digital Power Supply Input 1.71 to 5.5V
8 P1[4] RX | MOSI | SDA Yes Sensor Yes INN Yes
9 PO[4] RX | MOSI | SDA Yes Sensor Yes Yes INP Yes
10 PO[5] TX | MISO | SCL Yes Sensor Yes INN Yes
11 Po6] | RTS | SS Yes Sensor Yes SWDIO* Yes
12 P1[2] SS Yes Sensor Yes ouT Yes
13 VDDR Radio Power Supply 1.9V to 5.5V
14 P2[6] Sensor Yes INP Yes
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Module N Functionality
Solder Pad 51501 . Lco | weo . 2

Number UART | SPI 12C |[TCPWM| CapSense Drive out ECO_OUT SWD |SARMUX| OPAMP |LPCOMP| GPIO
15 P1[3] SS Yes Sensor Yes ouT Yes
16 P3[0] RX SDA Yes Sensor Yes Yes Yes
17 P2[1] SS Sensor Yes INN Yes
18 P2[2] SS Sensor Yes ouT Yes
19 P2[3] Sensor Yes Yes ouT Yes
20 VDDA Analog Power Supply Input 1.71 to 5.5V
21 P3[4] RX SDA Yes Sensor Yes Yes Yes
22 P3[1] X SCL Yes Sensor Yes Yes Yes
23 P3[7] | CRS Yes Sensor Yes Yes Yes Yes
24 P3[5] TX SCL Yes Sensor Yes Yes Yes
25 P3[3] | CTS Yes Sensor Yes Yes Yes
26 VREF Reference Voltage Inputs (Optional)
27 P3[2] | RTS Yes Sensor Yes Yes Yes
28 P3[6] | RTS Yes Sensor Yes Yes Yes
29 XRES External Reset Hardware Connection Input
30 P2[4] Sensor Yes INN Yes
31 P2[5] Sensor Yes INP Yes
32 GND Ground Connection

Notes

Z Timer, counter, pulse-width modulator (PWM); configurable as 16-bit timer, counter, PWM blocks

2 External Crystal Oscillator Output from the device/module

% General Purpose Input/Output

2 SDWCLK and SWDIO connections can be multiplexed as the functional options listed in each of the respective rows and can be
used for programming without the need to reconfigure the device I/O.

Host Recommended PCB Layout

To assist in the host PCB layout design for the CYBLE-014008-00, Cypress provides three host PCB reference
drawings in Figure 92, Figure 93, and in Figure 94 and Table 15. Figure 92 provides a dimensions view of the host
PCB layout. Figure 93 provides the location to the center edge of each solder pad relative to the origin of the module
(lower left PCB outline). Figure 94 and Table 15 provide the location to each solder pad center location for the host
PCB layout. Dimensions shown are in mm unless otherwise stated.
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Figure 92. Host Board Required PCB Layout Pattern (Dimensioned View)
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Note: Pad length shown includes overhang of the host pad beyond the module pad outline. The minimum recommended pad length on the host PCB is
0.99 mm.

Note: Pad 9 and Pad 24 have different dimensions than the rest of the connection pads (denoted in blue).
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Figure 93. Host Board Required PCB Layout Pattern: To Pad Center Edge Relative to Origin
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Getting Started With EZ-BLE™ Module

Figure 94. Host Board Required PCB Layout Pattern Table 15. Location to Pad Center from Origin
To Pad Center Relative to Origin (dimensions in mm and mils)
= & Solder Pad Location (X,Y) from | Location (X,Y) from
< 2 (Center of Pad) Origin (mm) Origin (mils)
0 (o
1 (0.30, 4.83) (11.81, 190.16)
2 (0.30, 5.49) (11.81, 216.14)
0,1 e AL1D
PADO ooy SADDA 3 (0.30, 6.15) (11.81, 242.13)
| (=i
| —h 4 (0.30, 6.81) (11.81, 268.11)
=4 o |
i & O 5 (0.30, 7.47) (11.81, 294.09)
| ¢ =il
15— h
DETALL & = = ) 6 (0.30, 8.13) (11.81, 320.08)
Pall = i L ——PAD32 7 (0.30, 8.79) (11.81, 346.06)
—-‘ TPY.0.20 8 (0.30, 9.45) (11.81, 372.05)
9 (0.27, 10.11) (10.63, 398.03)
€009 .
ORIGIN aL,m 10 (1.21, 10.70) (47.64, 421.26)
11 (1.87, 10.70) (73.62, 421.26)
- 12 (2.53, 10.70) (99.61, 421.26)
13 (3.19, 10.70) (125.59, 421.26)
DETAIL A
PAD CENTER \ 14 (3.85, 10.70) (151.57, 421.26)
DEFINITION 15 (4.51, 10.70) (177.56, 421.26)
| 0.494 '| 16 (5.17, 10.70) (203.54, 421.26)
| &2
| | MO 17 (5.84, 10.70) (229.92, 421.26)
1 T o |
e PAD CENTER | 18 (6.50, 10.70) (255.91, 421.26)
- — 19 (7.16, 10.70) (281.89, 421.26)
e} — 0,494
20 (7.82, 10.70) (307.87, 421.26)
21 (8.48, 10.70) (333.86, 421.26)
L 22 (9.14, 10.70) (359.84, 421.26)
23 (9.80, 10.70) (385.83, 421.26)
24 (10.73, 10.11) (422.44, 398.03)
25 (10.70, 9.45) (421.26, 372.05)
26 (10.70, 8.79) (421.26, 346.06)
27 (10.70, 8.13) (421.26, 320.08)
28 (10.70, 7.47) (421.26, 294.09)
29 (10.70, 6.81) (421.26, 268.11)
30 (10.70, 6.15) (421.26, 242.13)
31 (10.70, 5.49) (421.26, 216.14)
32 (10.70, 4.83) (421.26, 190.16)

WWW.Cypress.com Document No.: 001-96841 Rev. *E Need support? Click here. 83


http://www.cypress.com/

PERFORM
Getting Started With EZ-BLE™ Module

Figure 95 below details additional host board keep out area to achieve optimal RF performance with the CYBLE-
014008-00 module.
Figure 95. Host Board Additional Keep Out Area for Optimal RF Performance
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14.2.2 CYBLE-214009-00
The CYBLE-214009-00 is drop-in compatible with the CYBLE-014008-00 module. The CYBLE-214009-00 is a flash
and SRAM upgrade to the CYBLE-014008-00, moving from 128-KB flash and 16-KB SRAM to 256-KB flash and 32-

KB SRAM.
Figure 96 shows a physical picture of the CYBLE-214009-00 EZ-BLE PSoC module.

Figure 96. CYBLE-014008-00 Module Top View (with and without Shield) and Side View
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Side View of EZ-BLE PSoC Module Without Shield

For more details on this module’s dimensions, external component connections, and module placement
recommendations, see the CYBLE-214009-00 datasheet specification.

Pinout and Functionality

The CYBLE-214009-00 module is designed to mount as a component on an end-product PCB. Only a portion of the
available 1/0 of the PSoC BLE silicon device is exposed on the CYBLE-214009-00 module in order to minimize the
module footprint size. The CYBLE-214009-00 module contains 32 connections on the bottom side of the module.
Figure 97 details the bottom side connections available on the CYBLE-214009-00 module.
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CYBLE-214009-00 Module Bottom View

Figure 97.
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A list of the available I/Os and supported functionality for each 1/0 of the CYBLE-214009-00 is shown in Table 16.
Table 16. CYBLE-214009-00 Module Available Connections and Functionality

Module N Functionality
Solder Pad 51501 . Lco | wco " 27

Number UART | SPI 12C |TCPWM®| CapSense Drive out ECO_OUT SWD |SARMUX| OPAMP |LPCOMP| GPIO
1 GND Ground Connection
2 P1[1] SS Yes Sensor Yes INN Yes
3 P1[0] Yes Sensor Yes Yes INP Yes
4 P1[5] TX | MISO | SCL Yes Sensor Yes INP Yes
5 PO[1] TX | MISO | SCL Yes Sensor Yes INN Yes
6 PO[7] | CTS | SCLK Yes Sensor Yes SWDCLK?® Yes
7 VDD Digital Power Supply Input 1.71 to 5.5V
8 P1[4] RX | MOSI | SDA Yes Sensor Yes INN Yes
9 PO[4] RX | MOSI | SDA Yes Sensor Yes Yes INP Yes
10 PO[5] TX | MISO | SCL Yes Sensor Yes INN Yes
11 Po6] | RTS | SS Yes Sensor Yes SWDIO?® Yes
12 P1[2] SS Yes Sensor Yes ouT Yes
13 VDDR Radio Power Supply 1.9V to 5.5V
14 P2[6] Sensor Yes INP Yes
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Module N Functionality
Solder Pad 51501 - Lco | weo " 2

Number UART | SPI 12C |[TCPWM®| CapSense Drive out ECO_OUT SWD |SARMUX| OPAMP |LPCOMP| GPIO
15 P1[3] SS Yes Sensor Yes ouT Yes
16 P3[0] RX SDA Yes Sensor Yes Yes Yes
17 P2[1] SS Sensor Yes INN Yes
18 P2[2] SS Sensor Yes ouT Yes
19 P2[3] Sensor Yes Yes ouT Yes
20 VDDA Analog Power Supply Input 1.71 to 5.5V
21 P3[4] RX SDA Yes Sensor Yes Yes Yes
22 P3[1] X SCL Yes Sensor Yes Yes Yes
23 P3[7] | CRS Yes Sensor Yes Yes Yes Yes
24 P3[5] TX SCL Yes Sensor Yes Yes Yes
25 P3[3] | CTS Yes Sensor Yes Yes Yes
26 VREF Reference Voltage Inputs (Optional)
27 P3[2] | RTS Yes Sensor Yes Yes Yes
28 P3[6] | RTS Yes Sensor Yes Yes Yes
29 XRES External Reset Hardware Connection Input
30 P2[4] Sensor Yes INN Yes
31 P2[5] Sensor Yes INP Yes
32 GND Ground Connection

Notes

% Timer, counter, pulse-width modulator (PWM); configurable as 16-bit timer, counter, PWM blocks

% External Crystal Oscillator Output from the device/module

" General Purpose Input/Output

% SDWCLK and SWDIO connections can be multiplexed as the functional options listed in each of the respective rows and can be
used for programming without the need to reconfigure the device I/O.
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Host Recommended PCB Layout

To assist in the host PCB layout design for the CYBLE-214009-00, Cypress provides three host PCB reference
drawings in Figure 98, Figure 99, and in Figure 100 and Table 17. Figure 98 provides a dimensions view of the host
PCB layout. Figure 99 provides the location to the center edge of each solder pad relative to the origin of the module
(lower left PCB outline). Figure 100 and Table 17 provide the location to each solder pad center location for the host
PCB layout. Dimensions shown are in mm unless otherwise stated.

Figure 98. Host Board Required PCB Layout Pattern (Dimensioned View)
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Note: Pad length shown includes overhang of the host pad beyond the module pad outline. The minimum recommended pad length on the host PCB is
0.99 mm.

Note: Pad 9 and Pad 24 have different dimensions than the rest of the connection pads (denoted in blue).
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Figure 99. Host Board Required PCB Layout Pattern: To Pad Center Edge Relative to Origin
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Getting Started With EZ-BLE™ Module

Figure 100. Host Board Required PCB Layout Pattern Table 17. Location to Pad Center from Origin
To Pad Center Relative to Origin (dimensions in mm and mils)
= ’3 Solder Pad Location (X,Y) from | Location (X,Y) from
= = (Center of Pad) Origin (mm) Origin (mils)
<T <L
.y . 1 (0.30, 4.83) (11.81, 190.16)
2 (0.30, 5.49) (11.81, 216.14)
0,11 RIRIAIRIRRIRIRIA TR IR (11,11 3 0.30, 6.15 11.81, 242.13
| (0.30, 6.15) (11.81, 242.13)
ipe_ 1 00000000000000 0 —;,nzs
) - 4 (0.30, 6.81) (11.81, 268.11)
- 1|
— E% 5 (0.30, 7.47) (11.81, 294.09)
T
1 ‘ Eg 6 (0.30, 8.13) (11.81, 320.08)
DETAIL A : 4 =il
BADI = — PAD3Z 7 (0.30, 8.79) (11.81, 346.06)
* 8 (0.30, 9.45) (11.81, 372.05)
— | — [ 2L AL
9 (0.27, 10.11) (10.63, 398.03)
10 (1.21, 10.70) (47.64, 421.26)
0. (11,00
ORIGIN ! 11 (1.87, 10.70) (73.62, 421.26)
. 12 (2.53, 10.70) (99.61, 421.26)
13 (3.19, 10.70) (125.59, 421.26)
DETAIL & _ 14 (3.85, 10.70) (151.57, 421.26)
Fa&D CENTER N,
. DEFINITION 15 (4.51, 10.70) (177.56, 421.26)
f \ 16 (5.17, 10.70) (203.54, 421.26)
| 1
|I | N | 17 (5.84, 10.70) (229.92, 421.26)
| — - 18 (6.50, 10.70) (255.91, 421.26)
T———PAT CENTER
e / 19 (7.16, 10.70) (281.89, 421.26)
e — 0,454 / 20 (7.82, 10.70) (307.87, 421.26)
' 21 (8.48, 10.70) (333.86, 421.26)
_ 22 (9.14, 10.70) (359.84, 421.26)
— 23 (9.80, 10.70) (385.83, 421.26)
24 (10.73, 10.11) (422.44, 398.03)
25 (10.70, 9.45) (421.26, 372.05)
26 (10.70, 8.79) (421.26, 346.06)
27 (10.70, 8.13) (421.26, 320.08)
28 (10.70, 7.47) (421.26, 294.09)
29 (10.70, 6.81) (421.26, 268.11)
30 (10.70, 6.15) (421.26, 242.13)
31 (10.70, 5.49) (421.26, 216.14)
32 (10.70, 4.83) (421.26, 190.16)
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Figure 101 details additional host board keep out area to achieve optimal RF performance with the CYBLE-214009-

00 module.
Figure 101. Host Board Additional Keep Out Area for Optimal RF Performance
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15 Appendix C: EZ-BLE Evaluation Board Details

Appendix C provides detailed information on each EZ-BLE Evaluation Board. The information contained for each
subsection below includes the following:

m  Physical image for each EZ-BLE Evaluation marketing part number
m  What's included on the specific EZ-BLE Evaluation board

m  EZ-BLE Evaluation board connections to CY8CKIT-042-BLE
To jump to your specific EZ-BLE Evaluation board, click the marketing part number in the below list:

EZ-BLE PRoC Evaluation Boards

= CYBLE-022001-EVAL
m  CYBLE-012011-EVAL
= CYBLE-222005-EVAL

m  CYBLE-212019-EVAL
EZ-BLE PRoC Evaluation Boards

= CYBLE-014008-EVAL
= CYBLE-214009-EVAL

15.1 EZ-BLE PRoC Evaluation Board Details

15.1.1 CYBLE-022001-EVAL
Figure 102 shows the CYBLE-022001-EVAL connected to the CY8CKIT-042-BLE Kit. The EZ-BLE PRoC Module
(CYBLE-022001-00) is shown in the red box in Figure 102.

Figure 102. CYBLE-022001-EVAL (Left) Connected to CY8CKIT-042-BLE (Right)
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CYBLE-022001-EVAL Connections to CY8CKIT-042-BLE

The CYBLE-022001-00 module contains 21 connections on the bottom of the module. All but one of these
connections is present on the CYBLE-022001-EVAL evaluation board (Port 4[0] is connected to Cnod to enable
capacitive sensing on the CY8CKIT-042-BLE Pioneer Kit).

Figure 103 shows the CYBLE-022001-EVAL and highlights the elements on the top side of the board. The port-pin
connections shown below denote the EZ-BLE module connections on the evaluation board, not the CY8CKIT-042-
BLE baseboard connections.

Figure 103. CYBLE-022001-EVAL Board Top Side

EZ-BLE PROC Module
Cmod

]2 Header
{Bottom Side)
J1 Header

(Bottom Side)

PO_6 P1_4
PO_7
XRES P1_5

GND
VDD

P51
P50
P34 P35
PO_5 PO_4
: iE ®-r17 s
e LT P4_1
J3 Header —ESeol Sl VDDR GND
VDD L LR
VDDR PO_6 (SWDIO)
PO_7 (SWDCIK)
XRES
GND
VDD

Note: Connections not called out on J1 and J2 connection headers are NC (No Connect), where no physical connection is present between the
CYBLE-022001-00 EZ-BLE PRoC Module and the CYBLE-022001-EVAL board J1 and J2 headers.

J4 MiniProg3 Programming Header

Note: The EZ-BLE PRoC Module includes only 16 GPIOs. In order to maintain full capability of the CY8CKIT-042-BLE Pioneer Kit functionality, seven
of the Port-Pin connections do not completely match the CY8CKIT-042-BLE baseboard pin out. See Table 18 for the complete list of GPIOs available
on the CYBLE-022001-EVAL and the corresponding Port-Pin connection to the CY8CKIT-042-EVAL baseboard.

The CYBLE-022001-EVAL includes the following elements:

B Cmog: A 2.2-nF capacitor mounted on the evaluation board used with the CY8CKIT-042-BLE capacitive sensing
slider, buttons, and proximity sensors. Cmod iS connected to P4[0] on the CYBLE-022001-00 EZ-BLE PRoC
Module to enable capacitive sensing when connected to the CY8CKIT-042-BLE Kit.

®  J3 Header: A two-pin header that exposes VDD and VDDR. This header can be used to short the VDD and
VDDR. This jumper must be shorted when using the CYBLE-022001-EVAL with the MiniProg3 kit due to the fact
that the MiniProg3 kit only supplies VDD to the evaluation board. When using the CYBLE-022001-EVAL in
conjunction with the CY8CKIT-042-BLE Pioneer kit, this jumper connection does not matter, and it can be
connected or disconnected.

m  J4 Header: A five-pin header that exposes connections used for programming the EZ-BLE PRoC Module
Evaluation board by using the MiniProg3 kit, as shown in Figure 104.
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Figure 104. CYBLE-022001-EVAL Using CY8CKIT-002 MiniProg3

Pin Mapping
f -~ CY8CKIT-002 | CYBLE-022001-EVAL
; > VIARG VDD
GND GND
RES XRES
SCIK PO_7
SDAT PO_6

J5: A header that exposes P5[0] and P5[1], which can be used for IC communication (including high-speed IZC)
to the CYBLE-022001-00 EZ-BLE PRoC Module.

As mentioned previously, the port-pin connections do not completely match the CY8CKIT-042-BLE baseboard pin
out. Seven such connections exist on the CYBLE-022001-EVAL that do not align with the CY8CKIT-042-BLE
baseboard (highlighted in red in Table 18). Fortunately, PRoC BLE is configurable so that pin functions can be easily
re-assigned.

Table 18 details all connections on the CY8CKIT-042-BLE baseboard and provides the equivalent Port-Pin
connection on the CYBLE-022001-EVAL board. The port-pin list order is according on the CY8CKIT-042-BLE
baseboard physical connection pinout.

Table 18. CYBLE-022001-EVAL Port-Pin Connections to CY8CKIT-042-BLE Baseboard

CY8CKIT-042-BLE Baseboard CYB8CKIT-042-BLE Baseboard CYBLE-022001-EVAL
Connection Header Connection Port-Pin Connection Port-Pin
Ji1 PO[0] NC
Ji1 PO[1] NC
Ji1 PO[2] NC
Ji1 PO[3] NC
Ji1 PO[4] NC
Ji1 PO[5] NC
Ji1 VREF VREF
Ji1 P1[0] NC
Ji1 P1[1] NC
Ji1 P1[2] NC
J11 P1[4] P1[4]
Ji1 PO[6] PO[6]
Ji1 P1[3] NC
Ji1 PO[7] PO[7]
J11 P1[5] P1[5]
Ji1 XRES XRES
Ji1 P1[7] NC
Ji1 GND GND
Ji1 P1[6] NC
Ji1 VDD VDD
J12 GND GND
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CY8CKIT-042-BLE Baseboard CY8CKIT-042-BLE Baseboard CYBLE-022001-EVAL
Connection Header Connection Port-Pin Connection Port-Pin
J10 VDD VDD
J10 P3[6] P3[6]
J10 P3[7] P3[7]
J10 P3[4] NC
J10 P3[5] NC
J10 P3[2] NC
J10 P3[3] NC
J10 P3[0] NC
J10 P3[1] NC
J10 P4[0]? NC®
J10 P5[1] P5[1]
J10 P4[1] NC
J10 P5[0] P5[0]
J10 P2[6] P3[4]
J10 P2[7] P3[5]
J10 P2[4] PO[S]
J10 P2[5] PO[4]
J10 P2[2] P1[7]
J10 P2[3] P1[6]
J10 P2[0] NC
J10 P2[1] P4[1]
J10 VDDR VDDR
J10 GND GND

Notes
2 P4][0] is available on the EZ-BLE PRoC Module (CYBLE-022001-00). However, the CYBLE-022001-EVAL board utilizes this pin to connect the Cpoqg
capacitor to enable capacitive sensing functionality on the CY8CKIT-042-BLE Baseboard.
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15.1.2 CYBLE-012011-EVAL
The CYBLE-012011-EVAL is the evaluation board for both the CYBLE-012011-00 and the CYBLE-012012-10 EZ-

BLE PRoC modules. The CYBLE-012011-EVAL evaluation board contains the CYBLE-012011-00 module.
Figure 105 shows the CYBLE-012011-EVAL connected to the CYBCKIT-042-BLE Kit. The EZ-BLE PRoC Module
(CYBLE-012011-00) is shown in the red box in Figure 105.

Figure 105. CYBLE-012011-EVAL (Left) Connected to CY8CKIT-042-BLE (Right)

95

Document No.: 001-96841 Rev. *E Need support? Click here.

Www.cypress.com


http://www.cypress.com/

= ¥
=¥ CYPRESS
" PERFORM
Getting Started With EZ-BLE™ Module

CYBLE-012011-EVAL Connections to CY8CKIT-042-BLE

The CYBLE-012011-00 module contains 31 connections on the bottom side of the module. All of these connections
are present on the CYBLE-012011-EVAL evaluation board.

Figure 106 shows the CYBLE-012011-EVAL and highlights the elements on the top side of the board. The port-pin
connections shown below denote the EZ-BLE module connections on the evaluation board, not the CY8CKIT-042-
BLE baseboard connections.

Figure 106. CYBLE-012011-EVAL Board Top Side

EZ-BLE PROC Module

15 Header
12 Header
(Bottom side) Cmod
NC NC GND VDD
NC NC P3_6 P3_7
NC NC P3_4 P35
PI_O  VREF P32 P3_3
NC NC NC NC
PO_6 Pl1_4 P4_0 P51
PO_7 NC NC P5_0
XRES PI_5 P2.6 P35
GND Pl1_7 P24 PO_4
VDD Pi_6 £2:2 P2:3
16 Header P2_0 PO_S
VDDR GND
VDD VDDR J1 Header
(Bottom side)
13 Header

J4 MiniProg3 10-pin
Programming Header

Note: Connections denoted as NC (No Connect) indicates that there is no physical connection present between the CYBLE-012011-00 EZ-BLE PRoC
Module and the CYBLE-012011-EVAL board J1 and J2 headers.

Note: The EZ-BLE PRoC Module includes only 23 GPIOs. In order to maintain full capability of the CY8CKIT-042-BLE Pioneer Kit functionality, three
of the Port-Pin connections do not completely match the CY8CKIT-042-BLE baseboard pin out. See Table 19 for the complete list of GPIOs available
on the CYBLE-012011-EVAL and the corresponding Port-Pin connection to the CY8CKIT-042-EVAL baseboard.

The CYBLE-012011-EVAL includes the following elements:

B Cmod: A 2.2-nF capacitor mounted on the evaluation board used with the CY8CKIT-042-BLE capacitive sensing
slider, buttons, and proximity sensors. Cmod iS connected to P4[0] on the CYBLE-022001-00 EZ-BLE PRoC
Module to enable capacitive sensing when connected to the CY8CKIT-042-BLE Kit.

®  J3 Header: A two-pin headers and included that expose VDD, VDDA and VDDR. These headers can be used to
short the VDDR power connection to VDD. These jumpers must be shorted when using the CYBLE-012011-
EVAL with the MiniProg3 kit due to the fact that the MiniProg3 kit only supplies VDD to the evaluation board.
When using the CYBLE-012011-EVAL in conjunction with the CY8CKIT-042-BLE Pioneer kit, these jumper
connections do not matter, and they can be connected or disconnected.

m  J4 Header: A 10-pin header is included on the CYBLE-012011-EVAL kit that exposes connections used for
programming and debug with the MiniProg3 kit, as shown in Figure 107. The 10-pin ribbon cable included in the
MiniProg3 kit must be used for this connection.
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Figure 107. CYBLE-012011-EVAL Using CY8CKIT-002 MiniProg3 and 10-Pin Ribbon Cable

m  J5: A header that exposes P5[0] and P5[1], which can be used for 1C communication (including high-speed IZC)
to the CYBLE-012011-00 EZ-BLE PRoC Module.

J6 Header: A four-pin header is included on the CYBLE-012011-EVAL kit that exposes the P3[5] connection of
the CYBLE-012011-00 module and the P3[5] and P2[7] connections of the CY8CKIT-042-BLE baseboard. Two
jumpers are provided to short the connection as needed. The order of the pins and the silkscreen for J6 is below:

1) Pin 1: The silk screen of this connection reads “3.5”. This connection is routed to the P3[5] connection of the
CY8CKIT-042-BLE module.

2) Pin 2: The silk screen of this connection and Pin 3 reads “BLE P3.5". This means that this connection is
routed to P3[5] of the CYBLE-012011-00 module.

3) Pin 3: The silk screen of this connection and Pin 2 reads “BLE P3.5”. This means that this connection is
routed to P3[5] of the CYBLE-012011-00 module.

4) Pin 4: The silk screen of this connection reads “3.5*”. Using the legend on the evaluation board, this
indicates that this connection is routed to P2[7] of the CY8CKIT-042-BLE baseboard, which connects to
SW2 (physical switch) on the baseboard.

For example, if SW2 on the CY8CKIT-042-BLE is desired to be connected for development and debug, then Pin
3 and Pin 4 should be shorted on J6.

As mentioned previously, the port-pin connections of the CYBLE-012011-EVAL do not completely match the
CYB8CKIT-042-BLE baseboard pin out. Three such connections exist on the CYBLE-012011-EVAL that do not align

with the CY8CKIT-042-BLE baseboard (highlighted in red in Table 19). Fortunately, PRoC BLE is configurable so that
pin functions can be easily re-assigned.

Table 19 details all connections on the CY8CKIT-042-BLE baseboard and provides the equivalent Port-Pin
connection on the CYBLE-012011-EVAL board. The port-pin list order is according on the CY8CKIT-042-BLE
baseboard physical connection pinout.

Table 19. CYBLE-012011-EVAL Port-Pin Connections to CY8CKIT-042-BLE Baseboard

CY8CKIT-042-BLE Baseboard CYB8CKIT-042-BLE Baseboard CYBLE-012011-EVAL
Connection Header Connection Port-Pin Connection Port-Pin
Ji1 PO[0] NC
Ji1 PO[1] NC
Ji1 PO[2] NC
Ji1 PO[3] NC
Ji1 PO[4] NC
Ji1 PO[5] NC
Ji1 VREF VREF
J11 P1[0] P1[0]

Ji1 P1[1] NC
J11 P1[2] NC
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CY8CKIT-042-BLE Baseboard CY8CKIT-042-BLE Baseboard CYBLE-012011-EVAL
Connection Header Connection Port-Pin Connection Port-Pin

Ji1 P1[4] P1[4]
Ji1 PO[6] PO[6]
Ji1 P1[3] NC
Ji1 PO[7] PO[7]
Ji1 P1[5] P1[5]
Ji1 XRES XRES
Ji1 P1[7] P1[7]
Ji1 GND GND
Ji1 P1[6] P1[6]
Ji1 VDD VDD
J12 GND GND
J10 VDD VDD
J10 P3[6] P3[6]
J10 P3[7] P3[7]
J10 P3[4] P3[4]
J10 P3[5]% P3[5]*/ NC
J10 P3[2] P3[2]
J10 P3[3] P3[3]
J10 P3[0] NC
J10 P3[1] NC
J10 p4[0]** NC3
J10 P5[1] P5[1]
J10 P4[1] NC
J10 P5[0] P5[0]
J10 P2[6] P2[6]
J10 P2[7)* P3[5] / NC*
J10 P2[4] P2[4]
J10 P2[5] PO[4]
J10 P2[2] P2[2]
J10 P2[3] P2[3]
J10 P2[0] P2[0]
J10 P2[1] PO[5]
J10 VDDR VDDR
J10 GND GND

Notes

%0 p3[5] is routed to both P3[5] of the Pioneer kit as well as P2[7] of the pioneer kit. This is done in order to maintain the SW2 switch connection on the
baseboard and still allow for DTM mode operation on P3[5]. The J6 header is used to select if P3[5] of the module is routed to P2[7] of the
CYB8CKIT-042-BLE or to P3[5] of the CY8CKIT-042-BLE

3 P4[0] is available on the EZ-BLE PRoC Module (CYBLE-012011-00). However, the CYBLE-012011-EVAL board utilizes this pin to
connect to the Cnoq Capacitor to enable capacitive sensing functionality on the CY8CKIT-042-BLE Baseboard.
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15.1.3 CYBLE-222005-EVAL

Figure 108 shows the CYBLE-222005-EVAL connected to the CY8CKIT-042-BLE Kit. The EZ-BLE PRoC Module
(CYBLE-222005-00) is shown in the red box in Figure 108.

Figure 108. CYBLE-222005-EVAL (Left) Connected to CY8CKIT-042-BLE (Right)
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CYBLE-222005-EVAL Connections to CY8CKIT-042-BLE

The CYBLE-222005-00 module contains 22 connections on the bottom side of the module. All but one of these
connections is present on the CYBLE-222005-EVAL evaluation board (Port 4[0] is connected to Cmod to enable
capacitive sensing on the CY8CKIT-042-BLE Pioneer Kit).

Figure 109 shows the CYBLE-222005-EVAL and highlights the elements on the top side of the board. The port-pin
connections shown below denote the EZ-BLE module connections on the evaluation board, not the CY8CKIT-042-
BLE baseboard connections.

Figure 109. CYBLE-222005-EVAL Board Top Side

EZ-BLE PROC Module

Cmod P5_1
P56
i GND VDD
J2 Header s 3 P3_6 P3_7
(Bottom Side) & - -
éé J1 Header
VREF S (Bottom Side)
PO_6 P1_4 P5_1
PO_7 P5_0
XRES P1_5 P3_.4 P35
GND PO_5 PO_4
VDD P17 P1 6
P4_1
J3 Header gitsk— VDDR GND
VDD
VDDR J4 MiniProg3 10-Pin

Programming Header

Note: Connection not called out on J1 and J2 connection headers are NC (No Connect), where no physical connection is present between the
CYBLE-222005-00 EZ-BLE PRoC Module and the CYBLE-222005-EVAL board J1 and J2 headers.

Note: The CYBLE-222005-00 EZ-BLE PRoC Module includes only 16 GPIOs. In order to maintain full capability of the CY8CKIT-042-BLE Pioneer Kit
functionality, seven of the Port-Pin connections do not completely match the CY8CKIT-042-BLE baseboard pin out. See Table 20 for the complete list
of GPIOs available on the CYBLE-222005-EVAL and the corresponding Port-Pin connection to the CY8CKIT-042-EVAL baseboard.
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The CYBLE-222005-EVAL includes the following elements:

Cmod: A 2.2-nF capacitor mounted on the evaluation board used with the CY8CKIT-042-BLE capacitive sensing
slider, buttons, and proximity sensors. Cmod iS connected to P4[0] on the CYBLE-022001-00 EZ-BLE PRoC
Module to enable capacitive sensing when connected to the CY8CKIT-042-BLE Kit.

J3 Header: A two-pin header that exposes VDD and VDDR. This header can be used to short the VDD and
VDDR. This jumper must be shorted when using the CYBLE-222005-EVAL with the MiniProg3 kit due to the fact
that the MiniProg3 kit only supplies VDD to the evaluation board. When using the CYBLE-222005-EVAL in
conjunction with the CY8CKIT-042-BLE Pioneer kit, this jumper connection does not matter, and it can be
connected or disconnected.

J4 Header: A 10-pin header is included on the CYBLE-222005-EVAL kit that exposes connections used for
programming and debug with the MiniProg3 kit, as shown in Figure 110. The 10-pin ribbon cable included in the
MiniProg3 kit must be used for this connection.

Figure 110. CYBLE-222005-EVAL Using CY8CKIT-002 MiniProg3

®  J5: A header that exposes P5[0] and P5[1], which can be used for IC communication (including high speed IZC)
to the CYBLE-222005-00 EZ-BLE PRoC Module.

As mentioned previously, the Port-Pin connections do not completely match the CY8CKIT-042-BLE baseboard pin
out. Seven such connections exist that do not align with the CY8CKIT-042-BLE baseboard (highlighted in red in
Table 20). Fortunately, PRoC BLE is configurable so that pin functions can be easily re-assigned.

Table 20 details all connections on the CY8CKIT-042-BLE baseboard and provides the equivalent Port-Pin
connection on the CYBLE-222005-EVAL board. The port-pin list order is according on the CY8CKIT-042-BLE
baseboard physical connection pinout.

Table 20. CYBLE-222005-EVAL Port-Pin Connections to CY8CKIT-042-BLE Baseboard

CYB8CKIT-042-BLE Baseboard CY8CKIT-042-BLE Baseboard CYBLE-222005-EVAL
Connection Header Connection Port-Pin Connection Port-Pin
Ji1 PO[O] NC
Ji1 PO[1] NC
Ji1 PO[2] NC
Ji1 PO[3] NC
Ji1 PO[4] NC
Ji1 PO[5] NC
Ji1 VREF VREF
Ji1 P1[0] NC
Ji1 P1[1] NC
Ji1 P1[2] NC
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CY8CKIT-042-BLE Baseboard CY8CKIT-042-BLE Baseboard CYBLE-222005-EVAL
Connection Header Connection Port-Pin Connection Port-Pin
J11 P1[4] P1[4]
Ji1 PO[6] PO[6]
Ji1 P1[3] NC
Ji1 PO[7] PO[7]
Ji1 P1[5] P1[5]
Ji1 XRES XRES
Ji1 P1[7] NC
Ji1 GND GND
Ji1 P1[6] NC
Ji1 VDD VDD
J12 GND GND
J10 VDD VDD
J10 P3[6] P3[6]
J10 P3[7] P3[7]
J10 P3[4] NC
J10 P3[5] NC
J10 P3[2] NC
J10 P3[3] NC
J10 P3[0] NC
J10 P3[1] NC
J10 P4[0]* NC®
J10 P5[1] P5[1]
J10 P4[1] NC
J10 P5[0] P5[0]
J10 P2[6] P3[4]
J10 P2[7] P3[5]
J10 P2[4] PO[5]
J10 P2[5] PO[4]
J10 P2[2] P1[7]
J10 P2[3] P1[6]
J10 P2[0] NC
J10 P2[1] P4[1]
J10 VDDR VDDR
J10 GND GND

Notes
%2 p4_[0] is available on the EZ-BLE PRoC Module (CYBLE-222005-00). However, the CYBLE-222005-EVAL board utilizes this pin to connect the
Cnmod Capacitor to enable capacitive sensing functionality on the CY8CKIT-042-BLE Baseboard.

WWW.Cypress.com Document No.: 001-96841 Rev. *E Need support? Click here. 101


http://www.cypress.com/

Getting Started With EZ-BLE™ Module

=/ CYPRESS

15.1.4 CYBLE-212019-EVAL
Figure 111 shows the CYBLE-212019-EVAL connected to the CYBCKIT-042-BLE Kit. The EZ-BLE PRoC Module

(CYBLE-212019-00) is shown in the red box in Figure 111.
Figure 111. CYBLE-212019-EVAL (Left) Connected to CY8CKIT-042-BLE (Right)

Need support? Click here. 102

Document No.: 001-96841 Rev. *E

Www.cypress.com


http://www.cypress.com/

= ¥
=¥ CYPRESS
" PERFORM
Getting Started With EZ-BLE™ Module

CYBLE-212019-EVAL Connections to CY8CKIT-042-BLE

The CYBLE-212019-00 module contains 31 connections on the bottom side of the module. All of these connections
are present on the CYBLE-212019-EVAL evaluation board.

Figure 112 shows the CYBLE-212019-EVAL and highlights the elements on the top side of the board. The port-pin
connections shown below denote the EZ-BLE module connections on the evaluation board, not the CY8CKIT-042-
BLE baseboard connections.

Figure 112. CYBLE-212019-EVAL Board Top Side

EZ-BLE PROC Module

15 Header
12 Header
(Bottom side) Cmod
NC NC GND VDD
NC NC P3_6 P3_7
NC NC P3_4 P35
PI_O  VREF P32 P3_3
NC NC NC NC
PO_6 Pl1_4 P4_0 P51
PO_7 NC NC P5_0
XRES PI_5 P2.6 P35
GND Pl1_7 P24 PO_4
VDD Pi_6 £2:2 P2:3
16 Header P2_0 PO_S
VDDR GND
VDD VDDR J1 Header
(Bottom side)
13 Header

J4 MiniProg3 10-pin
Programming Header

Note: Connections denoted as NC (No Connect) indicates that there is no physical connection present between the CYBLE-212019-00 EZ-BLE PRoC
Module and the CYBLE-212019-EVAL board J1 and J2 headers.

Note: The EZ-BLE PRoC Module includes only 23 GPIOs. In order to maintain full capability of the CY8CKIT-042-BLE Pioneer Kit functionality, three
of the Port-Pin connections do not completely match the CY8CKIT-042-BLE baseboard pin out. See Table 21 for the complete list of GPIOs available
on the CYBLE-212019-EVAL and the corresponding Port-Pin connection to the CY8CKIT-042-EVAL baseboard.

The CYBLE-212019-EVAL includes the following elements:

B Cmod: A 2.2-nF capacitor mounted on the evaluation board used with the CY8CKIT-042-BLE capacitive sensing
slider, buttons, and proximity sensors. Cmod iS connected to P4[0] on the CYBLE-022001-00 EZ-BLE PRoC
Module to enable capacitive sensing when connected to the CY8CKIT-042-BLE Kit.

®  J3 Header: A two-pin headers and included that expose VDD, VDDA and VDDR. These headers can be used to
short the VDDR power connection to VDD. These jumpers must be shorted when using the CYBLE-212019-
EVAL with the MiniProg3 kit due to the fact that the MiniProg3 kit only supplies VDD to the evaluation board.
When using the CYBLE-212019-EVAL in conjunction with the CY8CKIT-042-BLE Pioneer kit, these jumper
connections do not matter, and they can be connected or disconnected.

m  J4 Header: A 10-pin header is included on the CYBLE-212019-EVAL kit that exposes connections used for
programming and debug with the MiniProg3 kit, as shown in Figure 113. The 10-pin ribbon cable included in the
MiniProg3 kit must be used for this connection.
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Figure 113. CYBLE-212019-EVAL Using CY8CKIT-002 MiniProg3 and 10-Pin Ribbon Cable
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m  J5: A header that exposes P5[0] and P5[1], which can be used for 1C communication (including high-speed IZC)
to the CYBLE-212019-00 EZ-BLE PRoC Module.

J6 Header: A four-pin header is included on the CYBLE-212019-EVAL kit that exposes the P3[5] connection of
the CYBLE-212019-00 module and the P3[5] and P2[7] connections of the CY8CKIT-042-BLE baseboard. Two
jumpers are provided to short the connection as needed. The order of the pins and the silkscreen for J6 is below:

5) Pin 1: The silk screen of this connection reads “3.5”. This connection is routed to the P3[5] connection of the
CYB8CKIT-042-BLE module.

6) Pin 2: The silk screen of this connection and Pin 3 reads “BLE P3.5”. This means that this connection is
routed to P3[5] of the CYBLE-212019-00 module.

7) Pin 3: The silk screen of this connection and Pin 2 reads “BLE P3.5". This means that this connection is
routed to P3[5] of the CYBLE-212019-00 module.

8) Pin 4: The silk screen of this connection reads “3.5*". Using the legend on the evaluation board, this

indicates that this connection is routed to P2[7] of the CY8CKIT-042-BLE baseboard, which connects to
SW2 (physical switch) on the baseboard.

For example, if SW2 on the CY8CKIT-042-BLE is desired to be connected for development and debug, then Pin
3 and Pin 4 should be shorted on J6.
As mentioned previously, the port-pin connections of the CYBLE-212019-EVAL do not completely match the
CYB8CKIT-042-BLE baseboard pin out. Three such connections exist on the CYBLE-212019-EVAL that do not align

with the CY8CKIT-042-BLE baseboard (highlighted in red in Table 21). Fortunately, PRoC BLE is configurable so that
pin functions can be easily re-assigned.

Table 21 details all connections on the CY8CKIT-042-BLE baseboard and provides the equivalent Port-Pin
connection on the CYBLE-212019-EVAL board. The port-pin list order is according on the CY8CKIT-042-BLE
baseboard physical connection pinout.

Table 21. CYBLE-212019-EVAL Port-Pin Connections to CY8CKIT-042-BLE Baseboard

CY8CKIT-042-BLE Baseboard CYB8CKIT-042-BLE Baseboard CYBLE-212019-EVAL
Connection Header Connection Port-Pin Connection Port-Pin
Ji1 PO[0] NC
Ji1 PO[1] NC
Ji1 PO[2] NC
Ji1 PO[3] NC
Ji1 PO[4] NC
Ji1 PO[5] NC
Ji1 VREF VREF
J11 P1[0] P1[0]

Ji1 P1[1] NC
J11 P1[2] NC
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CY8CKIT-042-BLE Baseboard CY8CKIT-042-BLE Baseboard CYBLE-212019-EVAL
Connection Header Connection Port-Pin Connection Port-Pin

Ji1 P1[4] P1[4]
Ji1 PO[6] PO[6]
Ji1 P1[3] NC
Ji1 PO[7] PO[7]
Ji1 P1[5] P1[5]
Ji1 XRES XRES
Ji1 P1[7] P1[7]
Ji1 GND GND
Ji1 P1[6] P1[6]
Ji1 VDD VDD
J12 GND GND
J10 VDD VDD
J10 P3[6] P3[6]
J10 P3[7] P3[7]
J10 P3[4] P3[4]
J10 P3[5]* P3[5]*/ NC
J10 P3[2] P3[2]
J10 P3[3] P3[3]
J10 P3[0] NC
J10 P3[1] NC
J10 P4[0]** NC*
J10 P5[1] P5[1]
J10 P4[1] NC
J10 P5[0] P5[0]
J10 P2[6] P2[6]
J10 P2[7)® P3[5] / NC*
J10 P2[4] P2[4]
J10 P2[5] PO[4]
J10 P2[2] P2[2]
J10 P2[3] P2[3]
J10 P2[0] P2[0]
J10 P2[1] PO[5]
J10 VDDR VDDR
J10 GND GND

Notes

% p3[5] is routed to both P3[5] of the Pioneer kit as well as P2[7] of the pioneer kit. This is done in order to maintain the SW2 switch connection on the
baseboard and still allow for DTM mode operation on P3[5]. The J6 header is used to select if P3[5] of the module is routed to P2[7] of the
CYB8CKIT-042-BLE or to P3[5] of the CY8CKIT-042-BLE

34 P4[0] is available on the EZ-BLE PRoC Module (CYBLE-212019-00). However, the CYBLE-212019-EVAL board utilizes this pin to
connect to the Cnoq Capacitor to enable capacitive sensing functionality on the CY8CKIT-042-BLE Baseboard.
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15.2 EZ-BLE PSoC Evaluation Board Details

15.2.1 CYBLE-014008-EVAL
Figure 114 shows the CYBLE-014008-EVAL connected to the CY8CKIT-042-BLE Kit. The EZ-BLE PSoC Module

(CYBLE-014008-00) is shown in the red box in Figure 114.
Figure 114. CYBLE-014008-EVAL (Left) Connected to CY8CKIT-042-BLE (Right)
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CYBLE-014008-EVAL Connections to CY8CKIT-042-BLE

The CYBLE-014008-00 module contains 32 connections on the bottom side of the module. All of these connections
are present on the CYBLE-014008-EVAL evaluation board.

Figure 114 shows the CYBLE-014008-EVAL and highlights the elements on the top side of the board. The port-pin
connections shown below denote the EZ-BLE module connections on the evaluation board, not the CY8CKIT-042-
BLE baseboard connections.

Figure 115. CYBLE-014008-EVAL Board Top Side

EZ-BLE PSoC Module

J6 Header
J2 Header GND VDD
(Bottom Side) P3_6 P3_7
PO_5 PO_4 P34 P3.5
P1_0 VREF P3 2 P33
P1.2 Pl1.] P3_0 P3_1
PO_6 P1_4 J1 Header
POs7Z P13 (Bottom Side)
XRES P1_5 P2 & P3.5
GND P2 4. P2.5
VDD P22 P23
PO_1 P2_1
VDDR GND
Jae Wit e J5 Header
J4 MiniProg3 10-Pin —0 vDDA
Programming Header L VDD
J3 Header L——————— VDDR
VDD

Note: Connections not called out on J1 and J2 connection headers are NC (No Connect), where no physical connection is present between the
CYBLE-014008-00 EZ-BLE PSoC Module and the CYBLE-014008-EVAL board J1 and J2 headers.

Note: The EZ-BLE PSoC Module includes only 25 GPIOs. In order to maintain full capability of the CY8CKIT-042-BLE Pioneer Kit functionality, three
of the Port-Pin connections do not completely match the CY8CKIT-042-BLE baseboard pin out. See Table 22 for the complete list of GPIOs available
on the CYBLE-014008-EVAL and the corresponding Port-Pin connection to the CY8CKIT-042-EVAL baseboard.

The CYBLE-014008-EVAL includes the following elements:

®  J3 and J5 Header: 2x two-pin headers and included that expose VDD, VDDA and VDDR. These headers can be
used to short the VDDA and VDDR power connections to VDD. These jumpers must be shorted when using the
CYBLE-014008-EVAL with the MiniProg3 kit due to the fact that the MiniProg3 kit only supplies VDD to the
evaluation board. When using the CYBLE-014008-EVAL in conjunction with the CY8CKIT-042-BLE Pioneer kit,
these jumper connections do not matter, and they can be connected or disconnected.

m  J4 Header: A 10-pin header is included on the CYBLE-014008-EVAL kit that exposes connections used for
programming and debug with the MiniProg3 kit, as shown in Figure 116. The 10-pin ribbon cable included in the
MiniProg3 kit must be used for this connection.
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Figure 116. CYBLE-014008-EVAL Using CY8CKIT-002 MiniProg3 and 10-Pin Ribbon Cable

m  J6 Header: A four-pin header is included on the CYBLE-014008-EVAL kit that exposes the P3[5] connection of
the CYBLE-014008-00 module and the P3[5] and P2[7] connections of the CY8CKIT-042-BLE baseboard. Two
jumpers are provided to short the connection as needed. The order of the pins and the silkscreen for J6 is below:

1
2)
3)

4)

Pin 1: The silk screen of this connection reads “K042 3.5”. This means that this connection is routed to
P3[5] of the CY8CKIT-042-BLE baseboard.

Pin 2: The silk screen of this connection reads “BLE 3.5”. This means that this connection is routed to P3[5]
of the CYBLE-014008-00 module.

Pin 3: The silk screen of this connection reads “BLE 3.5". This means that this connection is routed to P3[5]
of the CYBLE-014008-00 module. This is the same connection as Pin 2.

Pin 4: The silk screen of this connection reads “K042 2.7”. This means that this connection is routed to
P2[7] of the CY8CKIT-042-BLE baseboard, which connects to SW2 (physical switch) on the baseboard.

For example, if SW2 on the CY8CKIT-042-BLE is desired to be connected for development and debug, then Pin
3 and Pin 4 should be shorted on J6.

As mentioned previously, the port-pin connections of the CYBLE-014008-EVAL do not completely match the
CYB8CKIT-042-BLE baseboard pin out. Three such connections exist on the CYBLE-014008-EVAL that do not align
with the CY8CKIT-042-BLE baseboard (highlighted in red in Table 22). Fortunately, PSoC BLE is configurable so that
pin functions can be easily re-assigned. Note: P3[5] of the CYBLE-014008-00 module is routed to both the P3[5] and
P2[7] CY8BCKIT-042-BLE baseboard connections as stated in the J6 header description.

Table 22 details all connections on the CY8CKIT-042-BLE baseboard and provides the equivalent Port-Pin
connection on the CYBLE-014008-EVAL board. The port-pin list order is according on the CY8CKIT-042-BLE
baseboard physical connection pinout.

Table 22. CYBLE-014008-EVAL Port-Pin Connections to CY8CKIT-042-BLE Baseboard

CY8CKIT-042-BLE Baseboard CY8CKIT-042-BLE Baseboard CYBLE-014008-EVAL
Connection Header Connection Port-Pin Connection Port-Pin
Ji1 PO[0] NC
Ji1 PO[1]*® NC
Ji1 PO[2] NC
Ji1 PO[3] NC
J11 PO[4] PO[4]
J11 PO[5] PO[5]
Ji1 VREF VREF
J11 P1[0] P1[0]
J11 P1[1] P1[1]
Ji1 P1[2] P1[2]
J11 P1[4] P1[4]
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CY8CKIT-042-BLE Baseboard CY8CKIT-042-BLE Baseboard CYBLE-014008-EVAL
Connection Header Connection Port-Pin Connection Port-Pin

Ji1 PO[6] PO[6]
Ji1 P1[3] P1[3]
Ji1 PO[7] PO[7]
Ji1 P1[5] P1[5]
Ji1 XRES XRES
Ji1 P1[7] NC
Ji1 GND GND
Ji1 P1[6] NC
Ji1 VDD VDD
J12 GND GND
J10 VDD VDD
J10 P3[6] P3[6]
J10 P3[7] P3[7]
J10 P3[4] P3[4]
J10 P3[5]* P3[5]*/ NC
J10 P3[2] P3[2]
J10 P3[3] P3[3]
J10 P3[0] P3[0]
J10 P3[1] P3[1]
J10 P40 NC¥
J10 P5[1] P5[1]
J10 Pa[1]*’ NC*
J10 P5[0] P5[0]
J10 P2[6] P2[6]
J10 P2[7] P3[5] / NC
J10 P2[4] P2[4]
J10 P2[5] P2[5]
J10 P2[2] P2[2]
J10 P2[3] P2[3]
J10 p2[0]* PO[1]*®
J10 P2[1] P2[1]
J10 VDDR VDDR
J10 GND GND

Notes

* PO[1] is routed to the P2[0] connection on the CY8CKIT-042-BLE baseboard in order to allow for connection to the Proximity Sensor element on the
baseboard (if desired).

% P3[5] is routed to both P3[5] of the Pioneer kit as well as P2[7] of the pioneer kit. This is done in order to maintain the SW2 switch connection on the
baseboard and still allow for DTM mode operation on P3[5]. The J6 header is used to select if P3[5] of the module is routed to P2[7] of the
CYB8CKIT-042-BLE or to P3[5] of the CY8CKIT-042-BLE.

37 p4[0] and P4[1] are connected on the PSoC4A BLE Module to an on-board 2.2nF and 10nF capacitor respectively, so they are not available on the
module or the CYBLE-014008-EVAL board for connection.
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15.2.2 CYBLE-214009-EVAL
Figure 117 shows the CYBLE-214009-EVAL connected to the CY8CKIT-042-BLE Kit. The EZ-BLE PSoC Module

(CYBLE-214009-00) is shown in the red box in Figure 117.
Figure 117. CYBLE-214009-EVAL (Left) Connected to CY8CKIT-042-BLE (Right)
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CYBLE-214009-EVAL Connections to CY8CKIT-042-BLE

The CYBLE-214009-00 module contains 32 connections on the bottom side of the module. All of these connections
are present on the CYBLE-214009-EVAL evaluation board.

Figure 118 shows the CYBLE-214009-EVAL and highlights the elements on the top side of the board. The port-pin
connections shown below denote the EZ-BLE module connections on the evaluation board, not the CY8CKIT-042-
BLE baseboard connections.

Figure 118. CYBLE-214009-EVAL Board Top Side

EZ-BLE PSoC Module

J6 Header
J2 Header GND VDD
(Bottom Side) P3_6 P3_7
PO_5 PO_4 P34 P3.5
P1_0 VREF P3 2 P33
P1.2 Pl1.] P3_0 P3_1
PO_6 P1_4 J1 Header
POs7Z P13 (Bottom Side)
XRES P1_5 P2 & P3.5
GND P2 4. P2.5
VDD P22 P23
PO_1 P2_1
VDDR GND
Jae Wit e J5 Header
J4 MiniProg3 10-Pin —0 vDDA
Programming Header L VDD
J3 Header L——————— VDDR
VDD

Note: Connections not called out on J1 and J2 connection headers are NC (No Connect), where no physical connection is present between the
CYBLE-214009-00 EZ-BLE PSoC Module and the CYBLE-214009-EVAL board J1 and J2 headers.

Note: The EZ-BLE PSoC Module includes only 25 GPIOs. In order to maintain full capability of the CY8CKIT-042-BLE Pioneer Kit functionality, three
of the Port-Pin connections do not completely match the CY8CKIT-042-BLE baseboard pin out. See Table 23 for the complete list of GPIOs available
on the CYBLE-214009-EVAL and the corresponding Port-Pin connection to the CY8CKIT-042-EVAL baseboard.

The CYBLE-214009-EVAL includes the following elements:

®  J3 and J5 Header: 2x two-pin headers and included that expose VDD, VDDA and VDDR. These headers can be
used to short the VDDA and VDDR power connections to VDD. These jumpers must be shorted when using the
CYBLE-214009-EVAL with the MiniProg3 kit due to the fact that the MiniProg3 kit only supplies VDD to the
evaluation board. When using the CYBLE-214009-EVAL in conjunction with the CY8CKIT-042-BLE Pioneer kit,
these jumper connections do not matter, and they can be connected or disconnected.

m  J4 Header: A 10-pin header is included on the CYBLE-214009-EVAL kit that exposes connections used for
programming and debug with the MiniProg3 kit, as shown in Figure 119. The 10-pin ribbon cable included in the
MiniProg3 kit must be used for this connection.
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Figure 119. CYBLE-214009-EVAL Using CY8CKIT-002 MiniProg3 and 10-Pin Ribbon Cable

m  J6 Header: A four-pin header is included on the CYBLE-214009-EVAL kit that exposes the P3[5] connection of
the CYBLE-214009-00 module and the P3[5] and P2[7] connections of the CY8CKIT-042-BLE baseboard. Two
jumpers are provided to short the connection as needed. The order of the pins and the silkscreen for J6 is below:

5)
6)
7

8)

Pin 1: The silk screen of this connection reads “K042 3.5”. This means that this connection is routed to
P3[5] of the CY8CKIT-042-BLE baseboard.

Pin 2: The silk screen of this connection reads “BLE 3.5”. This means that this connection is routed to P3[5]
of the CYBLE-214009-00 module.

Pin 3: The silk screen of this connection reads “BLE 3.5". This means that this connection is routed to P3[5]
of the CYBLE-214009-00 module. This is the same connection as Pin 2.

Pin 4: The silk screen of this connection reads “K042 2.7”. This means that this connection is routed to
P2[7] of the CY8CKIT-042-BLE baseboard, which connects to SW2 (physical switch) on the baseboard.

For example, if SW2 on the CY8CKIT-042-BLE is desired to be connected for development and debug, then Pin
3 and Pin 4 should be shorted on J6.

As mentioned previously, the port-pin connections of the CYBLE-214009-EVAL do not completely match the
CYB8CKIT-042-BLE baseboard pin out. Three such connections exist on the CYBLE-214009-EVAL that do not align
with the CY8CKIT-042-BLE baseboard (highlighted in red in Table 23). Fortunately, PSoC BLE is configurable so that
pin functions can be easily re-assigned. Note: P3[5] of the CYBLE-214009-00 module is routed to both the P3[5] and
P2[7] CY8BCKIT-042-BLE baseboard connections as stated in the J6 header description.

Table 23 details all connections on the CY8CKIT-042-BLE baseboard and provides the equivalent Port-Pin
connection on the CYBLE-014008-EVAL board. The port-pin list order is according on the CY8CKIT-042-BLE
baseboard physical connection pinout.

Table 23. CYBLE-214009-EVAL Port-Pin Connections to CY8CKIT-042-BLE Baseboard

CY8CKIT-042-BLE Baseboard CY8CKIT-042-BLE Baseboard CYBLE-214009-EVAL
Connection Header Connection Port-Pin Connection Port-Pin
Ji1 PO[0] NC
Ji1 PO[1]*® NC
Ji1 PO[2] NC
Ji1 PO[3] NC
J11 PO[4] PO[4]
J11 PO[5] PO[5]
Ji1 VREF VREF
J11 P1[0] P1[0]
J11 P1[1] P1[1]
Ji1 P1[2] P1[2]
J11 P1[4] P1[4]
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CY8CKIT-042-BLE Baseboard CY8CKIT-042-BLE Baseboard CYBLE-214009-EVAL
Connection Header Connection Port-Pin Connection Port-Pin

Ji1 PO[6] PO[6]
Ji1 P1[3] P1[3]
Ji1 PO[7] PO[7]
Ji1 P1[5] P1[5]
Ji1 XRES XRES
Ji1 P1[7] NC
Ji1 GND GND
Ji1 P1[6] NC
Ji1 VDD VDD
J12 GND GND
J10 VDD VDD
J10 P3[6] P3[6]
J10 P3[7] P3[7]
J10 P3[4] P3[4]
J10 P3[5]* P3[5]*/ NC
J10 P3[2] P3[2]
J10 P3[3] P3[3]
J10 P3[0] P3[0]
J10 P3[1] P3[1]
J10 P4[0]*° NC*
J10 P5[1] P5[1]
J10 P4[1]*° NC*
J10 P5[0] P5[0]
J10 P2[6] P2[6]
J10 P2[7] P3[5] / NC
J10 P2[4] P2[4]
J10 P2[5] P2[5]
J10 P2[2] P2[2]
J10 P2[3] P2[3]
J10 p2[o]® Po[1]*®
J10 P2[1] P2[1]
J10 VDDR VDDR
J10 GND GND

Notes

% PO[1] is routed to the P2[0] connection on the CY8CKIT-042-BLE baseboard in order to allow for connection to the Proximity Sensor element on the
baseboard (if desired).

% P3[5] is routed to both P3[5] of the Pioneer kit as well as P2[7] of the pioneer kit. This is done in order to maintain the SW2 switch connection on the
baseboard and still allow for DTM mode operation on P3[5]. The J6 header is used to select if P3[5] of the module is routed to P2[7] of the
CYB8CKIT-042-BLE or to P3[5] of the CY8CKIT-042-BLE

40 p4[0] and P4[1] are connected on the PSoC4A BLE Module to an on-board 2.2nF and 10nF capacitor respectively, so they are not available on the
module or the CYBLE-214009-EVAL board for connection.

WWW.Cypress.com Document No.: 001-96841 Rev. *E Need support? Click here. 113


http://www.cypress.com/

3
V

"|!|n.
@

# CYPRESS

PERFORM

Getting Started With EZ-BLE™ Module

16  Appendix D: Code Examples

PSoC Creator includes a large number of code example projects. Figure 120. Code Examples in PSoC
These projects are available from the PSoC Creator Start Page, Creator

as Figure 120 shows. |/ Start Page | ————""
Example projects can speed up your design process by starting PSoC® Creator™

you off with a complete design, instead of a blank page. The
example projects also show how PSoC Creator Components can

. f : Recent Proj E
be used for various applications. Code examples and datasheets e;';g;f:;jm e =
are included, as Figure 121 shows. (] BLE_Temperature_Measremert 01 cyuri

] BLE_Heart_Rate_Sensorll.cywrk

In the Find Example Project dialog shown in Figure 121, you o e e

have several options:
Create New Project...

Open Exsting Project.

m  Filter for examples based on architecture or device family.

For EZ-BLE PRoC Module, use the PRoC BLE filter. Most of e e
the PRoC BLE example projects can be reconfigured to work Guick Start Guide
with the EZ-BLE PRoC Module by just changing the target T e cretor
device and the pin assignments. PoeC oo s

m  Select from the menu of examples offered based on the g St Vit P
Filter Options. There are more than 20 BLE example e o tote

projects for you to get started, as shown in Figure 121. (Gelting Started with PRaC BLE
Examples and Kits
m  Review the datasheet for the selection (on the xmammatis
s

Documentation tab)
Product Information

m  Review the code example for the selection. You can copy PSoC Creator
and paste code from this window to your project, which can pag g
help speed up code development. Peace
m  Or create a new project (and a new workspace if needed) Fracale
based on the selection. This can speed up your design Resources
process by starting you off with a complete basic design. You Cypress Dev Commurity ke

can then adapt that design to your application.

Figure 121. Code Example Projects with Sample Code

Find Example Project ?
Fiter Options )
I Documentation .~ Sample Code .a] I ar
Device Family: PRoC BLE L < J —]
TN -
Keyword: BLE w {
CYBLE_APT_RESULT_T apiResult;
Project Name
) CyGlobalIntEnable;
CapSense_CSD_P4_Trackpad_Gestures
BLE_TimeSync
BLE Temperature_Measurement apiResult = CyBle_Start (StackEventHandler);
BLE_Shared_Memory_Bootloader
BLE_Shared_Memory_Bootloadable . ) - .
BLE R, Spamtadonen if {apiResult != CYSLE_ERRCR_CK)
BLE_Proximity i
ELE_Phone_Alsrit /#* BLE stack initialization failed, chec
BLE_HID_Mouse CYASSERT (0) ¢
BLE_HID_Keyboard N (o
BLE_Heart_Rate_Sensor d
BLE_Heart_Rate_Collector
BLE Glucose_Meter CyBle_lasRegisterAttrCallback (IasEventHandle
BLE_FindMe -
BLE_BExtemal_Memory_Boctloader
BLE_BExtemal_Memory_Boctloadable for(::)
BLE_Device_Information_Service {

BLE_Cycling_Sensor

BLE Blood Pressure_Sensor static uint8 toggleTimeout = 0

BLE Battery Level CYBLE BLESS_STRTE_T blessState;

BLE_Alert Notffication uint8 intrStatus;
#* 5ingle API call to service all the BL
* called at least once in a BLE C

CyBle ProcessEvents();

< >

[ Add to Exsting Workspace Create New Workspace ] Cancel
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17  Appendix E: Example Project main.c

#include <Project.h>

#define LED ON (0u)
#define LED OFF (1u)
#define NO_ALERT (Ou)
#define MILD ALERT (1u)
#define HIGH ALERT (2u)
#define LED_TOGGLE_TIMEOUT (100u)
#define CAPACITOR TRIM VALUE 0x00003FFA

uint8 alertlLevel;

void TasEventHandler (uint32 event, void *eventParam)
{
/* Alert Level Characteristic write event */
if (event == CYBLE EVT IASS WRITE CHAR_CMD)
{
/* Read the updated Alert Level value from the GATT database */
CyBle IassGetCharacteristicValue (CYBLE IAS ALERT LEVEL,
sizeof (alertLevel), &alertlLevel);

void StackEventHandler (uint32 event, void *eventParam)

{
CYBLE BLESS CLK CFG_PARAMS T clockConfig;

switch (event)
{
/* Mandatory events to be handled by Find Me Target design */
case CYBLE EVT STACK ON:
/* load capacitors on the ECO should be tuned and the tuned value
* must be set in the CY SYS XTAL BLERD BB XO CAPTRIM REG */

CY SYS XTAL BLERD BB XO CAPTRIM REG = CAPACITOR TRIM VALUE;

/* Get the configured clock parameters for BLE sub-system */
CyBle GetBleClockCfgParam(&clockConfig);

case CYBLE EVT GAP DEVICE DISCONNECTED:
/* Start BLE advertisement for 30 seconds and update link
* status on LEDs */
CyBle GappStartAdvertisement (CYBLE ADVERTISING FAST) ;
Advertising LED Write (LED_ON);
alertLevel = NO ALERT;
break;
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case CYBLE EVT GAP DEVICE CONNECTED:
/* BLE link is established */
Advertising LED Write (LED OFF);
Disconnect LED Write (LED OFF);
break;

case CYBLE EVT GAPP ADVERTISEMENT START STOP:
if (CyBle GetState() == CYBLE STATE DISCONNECTED)
{
/* Advertisement event timed out, go to low power
* mode (Stop mode) and wait for device reset
* event to wake up the device again */
Advertising LED Write (LED OFF);
Disconnect LED Write (LED ON);
CySysPmSetWakeupPolarity (CY PM STOP WAKEUP ACTIVE HIGH) ;
CySysPmStop () ;

/* Code execution will not reach here */

}

break;

default:
break;

}

int main ()

{
CYBLE API RESULT T apiResult;

CyGlobalIntEnable;
apiResult = CyBle Start (StackEventHandler);

if (apiResult != CYBLE ERROR_OK)

{
/* BLE stack initialization failed, check your configuration */
CYASSERT (0) ;

}
CyBle IasRegisterAttrCallback(IasEventHandler);

for(;;)

{
static uint8 toggleTimeout = 0;
CYBLE BLESS STATE T blessState;
uint8 intrStatus;

/* Single API call to service all the BLE stack events. Must be
* called at least once in a BLE connection interval */
CyBle ProcessEvents();
/* Update Alert Level value on the blue LED */
switch (alertLevel)

{

case NO ALERT:
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Alert LED Write (LED OFF);
break;

case MILD ALERT:

toggleTimeout++;

if (toggleTimeout == LED TOGGLE TIMEOUT)

{
/* Toggle alert LED after timeout */
Alert LED Write(Alert LED Read() ~ 0x01);
toggleTimeout = 0;

}

break;

case HIGH ALERT:
Alert LED Write (LED_ON);
break;

}

/* Configure BLESS in Deep-Sleep mode */
CyBle EnterLPM(CYBLE BLESS DEEPSLEEP) ;

/* Prevent interrupts while entering system low power modes */
intrStatus = CyEnterCriticalSection();

/* Get the current state of BLESS block */
blessState = CyBle GetBleSsState();

/* If BLESS is in Deep-Sleep mode or the XTAL oscillator is turning on,
* then PRoC BLE can enter Deep-Sleep mode (1.3ulA current consumption) */
if (blessState == CYBLE BLESS_STATE ECO ON ||

blessState == CYBLE BLESS STATE DEEPSLEEP)

CySysPmDeepSleep () ;

}
else if (blessState != CYBLE BLESS STATE EVENT CLOSE)

{
/* If BLESS is active, then configure PRoC BLE system in

* Sleep mode (~1.6mA current consumption) */
CySysPmSleep () ;
}

else

{
/* Keep trying to enter either Sleep or Deep-Sleep mode */

}
CyExitCriticalSection (intrStatus);

/* BLE link layer timing interrupt will wake up the system from Sleep
* and Deep-Sleep modes */

}
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18 Appendix F: Regulatory Information

FCC:

FCC NOTICE:

The device CYBLE-022001-00, including the antenna 2450AT18B100 from Johanson Technology, complies with Part

15 of the FCC Rules. The device meets the requirements for modular transmitter approval as detailed in FCC public

€20 Notice DA00-1407.transmitter Operation is subject to the following two conditions: (1) This device may not cause
harmful interference, and (2) This device must accept any interference received, including interference that may
cause undesired operation.

CAUTION

The FCC requires the user to be notified that any changes or modifications made to this device that are not expressly
approved by Cypress Semiconductor may void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help

LABELING REQUIREMENTS

The Original Equipment Manufacturer (OEM) must ensure that FCC labelling requirements are met. This includes a
clearly visible label on the outside of the OEM enclosure specifying the appropriate Cypress Semiconductor FCC
) identifier for this product as well as the FCC Notice above. The FCC identifier is FCC ID: WAP2001.

In any case the end product must be labeled exterior with "Contains FCC ID: WAP2001"

ANTENNA WARNING

This device is tested with a standard SMA connector and with the antennas listed below. When integrated in the
OEMs product, these fixed antennas require installation preventing end-users from replacing them with non-approved
antennas. Any antenna not in the following table must be tested to comply with FCC Section 15.203 for unique
antenna connectors and Section 15.247 for emissions.

Table 24. Antenna Used for the CYBLE-022001-00 Module

Manufacturer Part Number Frequency Band Antenna Type Gain

Johanson Technologies 2450AT18B100 2.4 GHz Chip +0.5 dBi
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RF EXPOSURE

To comply with FCC RF Exposure requirements, the Original Equipment Manufacturer (OEM) must ensure to install
the approved antenna in the previous.

The preceding statement must be included as a CAUTION statement in manuals, for products operating with the
approved antennas in Table 24, to alert users on FCC RF Exposure compliance. Any notification to the end user of
installation or removal instructions about the integrated radio module is not allowed.

The radiated output power of CYBLE-022001-00 with the chip antenna mounted (FCC ID: WAP2001) is far below the
FCC radio frequency exposure limits. Nevertheless, use CYBLE-022001-00 in such a manner that minimizes the
potential for human contact during normal operation.

End users may not be provided with the module installation instructions. OEM integrators and end users must be
provided with transmitter operating conditions for satisfying RF exposure compliance.

INDUSTRY CANADA (IC) CERTIFICATION

CYBLE-022001-00 is licensed to meet the regulatory requirements of Industry Canada (IC),
License: IC: 7922A-2001

Manufacturers of mobile, fixed or portable devices incorporating this module are advised to clarify any regulatory
questions and ensure compliance for SAR and/or RF exposure limits. Users can obtain Canadian information on RF

exposure and compliance from www.ic.gc.ca.

This device has been designed to operate with the antennas listed in Table 24 above, having a maximum gain of 0.5
dBi. Antennas not included in this list or having a gain greater than 0.5 dBi are strictly prohibited for use with this
device. The required antenna impedance is 50 ohms. The antenna used for this transmitter must not be co-located or
operating in conjunction with any other antenna or transmitter.

IC NOTICE

The device CYBLE-022001-00 including the antenna 2450AT18B100 from Johanson technology, complies with
Canada RSS-GEN Rules. The device meets the requirements for modular transmitter approval as detailed in RSS-
GEN. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2)
This device must accept any interference received, including interference that may cause undesired operation.

LABELING REQUIREMENTS

The Original Equipment Manufacturer (OEM) must ensure that IC labelling requirements are met. This includes a
clearly visible label on the outside of the OEM enclosure specifying the appropriate Cypress Semiconductor IC
identifier for this product as well as the IC Notice above. The IC identifier is 7922A-2001. In any case, the end product
must be labeled in its exterior with "Contains IC: 7922A-2001"

EUROPEAN R&TTE DECLARATION OF CONFORMITY

Hereby, Cypress Semiconductor declares that the Bluetooth module CYBLE-022001-00 complies with the essential
requirements and other relevant provisions of Directive 1999/5/EC. As a result of the conformity assessment
procedure described in Annex Ill of the Directive 1999/5/EC, the end-customer equipment should be labeled as

follows:

All versions of the CYBLE-022001-00 in the specified reference design can be used in the following countries:
Austria, Belgium, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany, Greece, Hungary, Ireland,
Italy, Latvia, Lithuania, Luxembourg, Malta, Poland, Portugal, Slovakia, Slovenia, Spain, Sweden, The Netherlands,
the United Kingdom, Switzerland, and Norway.
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MIC JAPAN

CYBLE-022001-00 is certified as a module with type certification number 005-101007. End products that integrate
CYBLE-022001-00 do not need additional MIC Japan certification for the end product.

End product can display the certification label of the embedded module.

ﬁ/lodel Name: EZ-BLE PRoC Module \
Part Number: CYBLE-022001-00

Manufactured by Cypress Semiconductor.

= [R] 005-101007
-

. J

KC Korea
CYBLE-022001-00 is certified for use in Korea with certificate number MSIP-CRM-Cyp-2001.

= S MREE:

1. HE3Y(RLY): SHAZHIREII(RHUOIESAAAEE 24I|]), CYBLE-022001-00

Ol A A2 X Cypress Semiconductor Corporation
4. HMIZ= & Xt 2015.04
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Document History

Document Title: AN96841 — Getting Started With EZ-BLE™ Module

Document Number: 001-96841

Revision

ECN

Orig. of
Change

Submission Date

Description of Change

*%

4715534

DSO

04/08/2015

New application note

*A

4763637

DSO

05/12/2015

Added associated project to this application note

Separated Development Tools and Development Kits in More
Information on Page 2 as well as in content of document

Updated Table 3 to remove functions that are not functional with the
module (i.e. EXTPA_EN, EXT_CLK)

Added footnote definitions for TCPWM, ECO_OUT, and GPIO in
Table 3

Added footnote definitions for IMO, WDT, ILO, and SCB on Page 7
Specified “Typical” for Power Consumption shown in Figure 4
Added Figure 6 to Page 8

Updated BLE Overview content throughout Pages 9~18

Updated Figure 26 to remove P1[3] as a connected GPIO on the
CYBLE-022001-EVAL board

Updated Table 3 to highlight the seven connections in red text on the
CYBLE-022001-00 that do not match those of the CY8CKIT-042-BLE
Baseboard

Updated flow and text in “My First EZ-BLE PRoC Module Design”
section. All sections updated (Part 1, Part 2, Part 3, and Part 4)

Updated all links throughout to final web links

Added Appendix D for additional information on BLE Protocol
Added Appendix E with entire main.c code example

Added Appendix F detailing Regulatory Information

*B

4803518

DSO

06/19/2015

Updated the following figures with the latest screen captures: Figure
6, Figure 7, Figure 37, Figure 38, Figure 39, Figure 40, Figure 41,
Figure 42, Figure 43, Figure 44, Figure 45, Figure 46, Figure 59

Updated PSoC Creator section

Updated Figure 12, and Figure 13 with final Evaluation Board Images
Added Figure 27, Figure 28, and Figure 29 for instructions on how to
update components with the Component Update Tool

Updated Appendix F: Regulatory Information to add MIC (Japan) and
KC (Korea) certification information

*C

4860212

DSO

07/27/2015

Added support link to page footers

*D

4925758

DSO

09/25/2015

Change Title of Application Note from “Getting Started With EZ-
BLE™ PRoC™ Module” to “Getting Started With EZ-BLE™ Module”

Update Associated Part Family to “CYBLE-XXXXXX-XX” to represent
all EZ-BLE Modules

Update supported PSoC Creator Version to V3.2 and higher

General update throughout Application Note body making it general
to the EZ-BLE family and not specific to the EZ-BLE PRoC Module

Updated Figure 32 with the latest screen capture

Added Appendix B: EZ-BLE Module Product Details, detailing
specific information on each EZ-BLE Module part number

Added Appendix C: EZ-BLE Evaluation Board Details, detailing
specific information on each EZ-BLE Evaluation board

Update EZ-BLE Module Overview to split into four sub-sections: 3.1.
EZ-BLE Module Family Features; 3.2. EZ-BLE Module Low Power
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Change

Modes; 3.3. Device Security; and 3.4. EZ-BLE Module Marketing Part
Number Overview

Removed Bluetooth Low Energy (BLE) Overview (previous section 3)
and added reference to this content in AN91267 - Getting Started
with PSoC® 4 BLE in the More Information section

Updated EZ-BLE Evaluation Boards section to provide general
information on EZ-BLE Evaluation boards and refer to Appendix C:
EZ-BLE Evaluation Board Details for additional information for
specific evaluation board part numbers

Added Section 7, Module Placement and Orientation Considerations
in a Host System to this Application Note

Added Section 8, Manufacturing with EZ-BLE Modules to this
Application Note

Updated Creator Software references from version 3.2 to version 3.3
SP1 or newer.

Added reference to PRoC BLE and PSoC 4 BLE 256KB Flash silicon
devices.

Updated Table 2 to add new module part numbers: CYBLE-012011-
00, CYBLE-012012-10, CYBLE-214009-00, and CYBLE-212019-00.

Updated Table 3 to add new module evaluation board part numbers:
CYBLE-012011-EVAL, CYBLE-214009-EVAL, and CYBLE-212019-
EVAL.

Updated PSoC Creator Figures throughout based on latest version
3.3 SP1 release.

Updated Component Update Process in Figure 24, Figure 25, Figure
*E 5037763 DSO 12/14/2015 26, Figure 27, Figure 28, and Figure 29 based on Creator 3.3 SP1
process.

Updated Appendix B: EZ-BLE Module Product Details to include new
module marketing part numbers added. Organize modules in
Appendix B: EZ-BLE Module Product Details based on PRoC BLE
processor and PSoC BLE processor. .

Updated mechanical drawings and tables throughout Appendix B to
latest format.

Updated Appendix C: EZ-BLE Evaluation Board Details to include
new module evaluation board marketing part numbers added.
Organize modules in Appendix C: EZ-BLE Evaluation Board Details
based on PRoC BLE processor and PSoC BLE processor.

Updated Component Library in associated example project for
compatibility to PSoC Creator 3.3 SP1.
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Worldwide Sales and Design Support

Cypress maintains a worldwide network of offices, solution centers, manufacturer's representatives, and distributors. To find
the office closest to you, visit us at Cypress Locations.

Products PSoC® Solutions

Automotive cypress.com/go/automotive psoc.cypress.com/solutions

Clocks & Buffers cypress.com/go/clocks PSoC 1| PSoC 3| PSoC 4 | PSoC 5LP

Interface cypress.com/go/interface Cypress Deve|oper Community
Lighting & Power Control cypress.com/go/powerpsoc Community | Forums | Blogs | Video | Training
Memor cypress.com/go/memory .

PSoC ' cypress.com/go/psoc Technical Support

Touch Sensing cypress.com/go/touch cypress.com/go/support

USB Controllers cypress.com/go/usb

Wireless/RF cypress.com/go/wireless

PSoC is a registered trademark and PSoC Creator is a trademark of Cypress Semiconductor Corp. All other trademarks or registered trademarks
referenced herein are the property of their respective owners.

Cypress Semiconductor Phone : 408-943-2600
198 Champion Court Fax : 408-943-4730
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CYPRESS San Jose, CA 95134-1709 Website : www.cypress.com
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© Cypress Semiconductor Corporation, 2015. The information contained herein is subject to change without notice. Cypress Semiconductor
Corporation assumes no responsibility for the use of any circuitry other than circuitry embodied in a Cypress product. Nor does it convey or imply any
license under patent or other rights. Cypress products are not warranted nor intended to be used for medical, life support, life saving, critical control or
safety applications, unless pursuant to an express written agreement with Cypress. Furthermore, Cypress does not authorize its products for use as
critical components in life-support systems where a malfunction or failure may reasonably be expected to result in significant injury to the user. The
inclusion of Cypress products in life-support systems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies
Cypress against all charges.

This Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is protected by and subject to worldwide
patent protection (United States and foreign), United States copyright laws and international treaty provisions. Cypress hereby grants to licensee a
personal, non-exclusive, non-transferable license to copy, use, modify, create derivative works of, and compile the Cypress Source Code and derivative
works for the sole purpose of creating custom software and or firmware in support of licensee product to be used only in conjunction with a Cypress
integrated circuit as specified in the applicable agreement. Any reproduction, modification, translation, compilation, or representation of this Source
Code except as specified above is prohibited without the express written permission of Cypress.

Disclaimer: CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS MATERIAL, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Cypress reserves the
right to make changes without further notice to the materials described herein. Cypress does not assume any liability arising out of the application or
use of any product or circuit described herein. Cypress does not authorize its products for use as critical components in life-support systems where a
malfunction or failure may reasonably be expected to result in significant injury to the user. The inclusion of Cypress’ product in a life-support systems
application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all charges.

Use may be limited by and subject to the applicable Cypress software license agreement.
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